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Introduction 
Power*Core™(Petrographical Office Wellsite Evaluation and Reporting) is a chip and core logging management 
program that utilizes single-entry data capturing to produce geological striplogs. The geological data is entered into 
the system through the use of intuitive data entry forms to ensure standardization of data. This data is stored in an 
RDBMS(Relational Database Management System) to allow data manipulation using SQL access tools. 
Power*Core™ software consists of four (4) main parts: 
A log editor module that allows you to change the striplogs to suit your needs and preferences. 
A data transfer module. 
Report printing modules. 
An on-line help system that is designed to familiarize you with the commands and functions available in 
Power*Core™ and lead you through many of the processes involved in creating logs. 
A note about navigating through Power*Core™: 
When you are entering information into data forms, you may move between boxes/fields by pressing the Tab key to 
go forward and Shift +Tab keys to move backwards. To exit forms that do not have an Exit, OK, or Cancel button, 
press the Esc key on the keyboard. 
To access the On-line Help System in Power*Core™: 
You can make use of the context sensitive help by pressing the F1 key when you are in a dialogue box. A pertinent 
help file will appear, opened to the topic relevant to the dialogue box you are in. 
Below are some examples of common features within Power*Core™: 
The Toolbar 

 

The Selection Bar 

 
Selection Bar Using the Default American Style Inches Screen Scale 

 
Selection Bar Utilizing a Ratio for Screen Scale 
Import Toolbar 
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Export Toolbar 

 
RTF Font Toolbar 
Turns the RTF Font Toolbar on and off. This toolbar is dock able and can be moved to different places on the screen. 
This is used with the New RTF Annotations used on the Log. 

 
RTF Line and Boxes Toolbar 
Turns the RTF Line and Boxes Toolbar on and off. This toolbar is dock able and can be moved to different places on 
the screen. This is used with the New RTF Annotations used on the Log. 

 
Status Bar 
Turns the Status Bar, located at the bottom of the Power*Log / Core & Curve™ screen, on and off. 
This is the Power*Log / Core & Curve™ Status Bar… 
The Status Bar displays system status and any error messages in the lower left corner of the screen.  If there are no 
errors the status bar will indicate "For Help, press F1". 

 
Note: The KB Elevation is displayed in the lower right corner of the Status Bar 
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The On-line Help is divided into four(4) main categories: 
 
Commands - Descriptions of each menu command within Power*Log™. 
 
Toolbar - Shortcuts to common commands are explained. 
 
Database Table Operations - Commands/functions related to the Database Table are described. 
 
Quick Reference Guide - The portion of the On-line Help System, that quickly refers you to some of the more 

commonly performed tasks. 
 

This tutorial will guide you through the process of creating and editing a core log. 
 
Connecting to the Database 

1.) Double click on the  Icon. Acknowledge the Security Information window by clicking on the  
button. This will initiate the program and activate a Connect Database window. 

 
2.) Highlight the PGEOLOGY 2016 IMPERIAL (Microsoft Access Driver[*.mbd]) database. 
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field. 

Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field. 

4.) Type “pgeology” in the Password field and then click on the  button. The program will now load 
various dictionaries and then activate an Open Log window. 

Creating a New Well / Log 

The first step in creating a new log is to click on the  New Log button on the Toolbar or to select New under 
File on the Selection Bar. This will open the New Log window. 

This more than likely will appear after connecting to the Database without you have to do the above procedure if this 
was the first time you have activated Power*Core. 

 

1.) The Well/Log Name field is where you enter the name of the well (no more than 50 characters long). Type 
“Tutorial Core Log” into the Well / Log Name field. 
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2.) Click on the  button to activate the UWI / API Format window. 

 

3.) The default or flashing caret is in the API Code / Name field. Type in “23001201300000”. The 23 is a State 
Code, the 001 is a County Code, the 20130 is the Unique Well ID, the 00 is for the sidetrack code, and the last 
00 is for the Event Sequence. 

4.) Click on the  button when you have finished entering the UWI. 

5.) Click on the  button to activate the Log Format List window. 

 

6.) Click on “V SYSTEM Facies Log [SYSTEM (I)]” to highlight it and then click on the  button. You may 
also double click on “V SYSTEM Core Log (BR) grid off [SYSTEM (I)]” 

7.) Once you have been returned to the New Log window, double click in the Log Start Depth field. This will 
highlight the zero (0) and activate a flashing cursor. Type 790 in the Log Start Depth field. 

8.) Activate the Facies Interval Check box  as shown above. 

9.) Once the information is entered, click on the  button. This will initiate the New Log and activate a 
window named For Layer ‘Environment’. 

There will be number of Add Curves windows presented to the user to identify, Curve Name, Units, Null Values, 
Scales, Backup Scales and Grid Type. The User can change any or all of these curve options. 

10.) Click on the  button for the Add Curve Windows for SP and Gamma Ray Curves as the default 
values are good. 

         
11.) When the Density and Neutron Porosity Curves are added you will need to change the left scales from 

60.0000 to 0.60. The examples of each are shown below. This is done as the values in the curves being 
imported to these curves are fractional and not in percentage format. If you do not do this your curves will import 



2016                                     Power*Core Imperial Tutorial 
 

Imperial Tutorial   Page 9 

but will not show and you will have to change scales from the right click menu. Now Click on the  
button for the Add Curve Windows for Density and Neutron Porosity once the scale values are good. 

         

         

12.) Click on the  button 3 times for the Add Curve Windows for Deep, Medium and Shallow Induction 
Curves as the default values are good. 

       
13.) The next piece of information required for the log in the addition of the V Shale calculations GR Layer. The layer 

requires a Gamma Ray curve so the User must select the previously entered Gamma Ray Curve. Click on 

“Gamma Ray (gapi)” to highlight it and then click on the  button. You may also double click on 
“Gamma Ray (gapi)” 

 
14.) This will activate the GR values for a clean Sand and a clean Shale. In our case we will utilize 20 gapi units for a 

clean sand and 120 gapi units for a clean shale. Type those values into the fields and click on the  
button. 

 
The log you have selected has an Interpretive Facies Layer that can utilize existing groups (in your case none exist) 
or add new ones. These layers allow the user to define an interval with a color and/or pattern as well as a long name 
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or short name displayed in various ways, This layer also controls the Automated Dean Starks and Automated Test 
Interval Indicators. 

 
15.) This will activate the Enter a New Group Id for the Depositional Environment. Type in Facies and Click on the 

 button 
The log you have selected has one generic fill category that can utilize existing groups (in your case none exist) or 
add new ones. These layers allow the user to define an interval with a color and/or pattern as well as a long name or 
short name displayed in various ways. These are catch all categories that can be used for all sorts of data types. The 
one that is associated with this core log is called Depositional Environments. 

 
16.) This will activate the Enter a New Group Id for the Depositional Environment. Type is Depositional 

Environment and Click on the  button 
17.) Lastly for this log creation the User will have to identify the Core Photo Graphic Group for the Core Photo 

Stacking, Core# and sleeve data and the Core Photo Magnify Layers. The User can type in 1 in the 4 separate 

windows and then Click on the  button 4 separate times. 
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**When the Core log opens, it should resemble this log.** 

 
1.) You can now fill in your pertinent well information by selecting Well under Edit pull down menu on the Selection 

Bar to activate the Well window. 

 
2.) Fill in the information you feel is necessary (The well window shown above has been filled in to give you an idea 

of how to complete the fields) and then click on the  button to save any changes you have made to the 
database. 

Note: Some of the fields in the Well window have character restrictions or mandatory requirements. Consequently, if 
any of these restrictions have been violated or if any requirements have not been met, the offending field will be 
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highlighted. The nature of the problem will be displayed on the Status Bar (lower left corner of the screen), and you 
will be prompted with a system error message window. 

3.) If the record has been successfully saved, click on the  button, when prompted with the Shortcut 
Options window. 

 
The System Options Window 
To activate the System Options window click on the Options selection on the menu toolbar and then select the 
System Options selection to activate the System Options window. 
General Tab 

 
Home Directory - This is the directory on your hard drive where Power*Log, Power*Core and Power*Curve is 
being executed. The user will not see any symbols on their log or print out any of our reports it you have the wrong 
home directory. 

 This check box when  activated will populate the Open Log window with all the wells in the 
database. If it is unchecked it may help our corporate users and the time it take to retrieve thousands of wells from 
the database and to populate the Open Log window with that information. If this check box is deactivated and you 

wish to see all your wells then simply click on the  button in the Open Log window to see all their wells if 
this option is deactivated. 

Date Format - From this drop box, you can select the date format. This selection determines how 
every date in Power*Log / Core & Curve will be entered and displayed. If you import a log with 
different date formats, Power*Log / Core & Curve will change the dates to comply with the format 
you've chosen here. The user can change this at any time and all the Date formats will be 
changed in the database. 
 

Version Compatibility - Enables the user to achieve compatibility for Annotations in the older Versions of 
Power*Suite (V1.81 and before) and the Annotations in the newer Versions of Power*Suite (V1.9 and later). 
Data Buffer Lookahead - The number placed in this field determines how far ahead and behind the current top 
depth will be stored in the computers buffer. The larger the look ahead number, the longer it takes for Power*Log / 
Core & Curve to refresh the screen when you exceed the look ahead value. However, until you meet or exceed the 
look ahead value, scrolling will be much faster, because the database is not yet being accessed. 
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Fonts Tab 
This tab allows the user to set up most if not all of the fonts used in Power*Log, Core and Curve. You can set 
it up to be used on the current log as well as using the fonts as your defaults when you are making new logs. 

 
Annotation Font - Allows you to determine the default font style, type, color and size of your annotations on your log, 
Also this is the default when you use any of the Sample Description Transfer options. 
Survey Font - Allows you to determine the font style, type, color and size of your survey data associated with the 
Survey Layer on your log. 
Bit Record Font - Allows you to determine the font style, type, color and size of your bit record data associated with 
the Bit Record Layer on your log. 
Generic Category Font - Allows you to determine the font style, type, color and size of your Long or Short Name 
display option in all the Generic Category Layers displayed on your log. 
Depth Font - This allows you to determine the font style, type, color and size of the depth markers in the Depth track 
of the log. 

 - These radio buttons allows the user to change the orientation of the Depth Font on the 
Layer. Beware you may have to change the Track Width to accommodate the Font size and orientation. Refer to the 
Log Configuration Builder to do this. 

 This check box  when activated will display the depth units with the depth on the Depth Layer. ie. 
1000 or 1000 ft. vs. 1000 ft. tvd. 
Track Header Font - Allows you to determine the font style, type, color and size of your Track Headers on your log. 
All track headers use the same font across the entire log. 
Layer Header Font - Allows you to determine the font style, type, color and size of your Layer Headers on your log. 
All Layer headers use the same font across the entire log. 
Formation Tops Font - Allows you to determine the font style, type, color and size of your Formation Tops data 
associated with the Formation Tops Long and Expanded Layers on your log. 
Offscale Font - Allows you to determine the font style, type, color and size of your curve values displayed when the 
curve pegs off scale.  
Core Box Font - Allows you to determine the font style, type, color and size of your Core Box data entered in the 
Core Box layer. 
Casing String Font - Allows you to determine the font style, type, color and size of your Casing string data displayed 
on the Casing String layer. This data is entered through the Casing String Report. 
Date Font - Allows you to determine the font style, type, color and size of your Date data entered in the Date layer. 
Core Sample Code Font - Allows you to determine the font style, type, color and size of your Core Plug data entered 
through the Core Plug Report. This font is displayed on the Core Sample Code layer. 
Sidewall Core Font - Allows you to determine the font style, type, color and size of your Sidewall Run and Sample 
Number data entered through the Sidewall Core Report. This font is displayed on the Sidewall Core layer. 
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MDT Font - Allows you to determine the font style, type, color and size of your MDT Run and Test Number data 
entered through the MDT Report. This font is displayed on the MDT layer. 

 This check box  when activated will make the font setting in this window your defaults for 
any new log created regardless on the Fonts stored in the template. 
How to Set your Fonts. 
1. Click on System Options selection under the Options menu selection To activate the System Options window. 
2. Then click on the Font Tab to activate the Tab. 

3. Click on the  button beside the MDT Font option that we wish to change and this will activate the Font 
Window. 

 
4. Select form the Font (Arial), Font Style (Regular), Size (12) and Color (Red). When you are finished click on the 

 button 
5. Repeat steps 2-4 for all Font types that you wish to change. 

6. Click on the  button. 
7. If you want to set these as your default Font settings click on the  check box. 

8. Click on the  button in the Systems Options Tab dialogue window. 

Display Tab 
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Arrowed Subintervals - This check box  when activated will indicate the top and bottom of your subintervals 
(portion of an interval) with an arrow rather than a set of symbols. An example is shown below. 

                     
 Normal Subintervals Arrowed Subintervals 
Transparent - This check box  when activated, this function makes the background of the accessory symbols 
transparent, so that the bed in the background shows through. If deactivated, a white background surrounds the 
accessory symbols in order to separate them more from the beds. 
Use Global Symbols – With the ability to edit existing metafiles the user may have imported a well that has used 
metafiles or symbols that have been modified to look differently than the one existing within your system symbols. If 
you wish to use your symbol set instead of the revised imported ones you can select this check box  to make that 
change. 
Interbed Line Display Type - This check box  when activated will display the interbed data with a line display 
splitting the two lithology types or when unchecked will display the lithology in an interbed fashion as displayed below. 

                      
Curve Backup fill – This check box  when activated will show a sideways hatching fill pattern when a curve goes 
off scale or in the backup mode. If unchecked there will be no hatching pattern when the curve goes off scale. 
Frequency @ 1:240 – This drop box determines how often symbols are drawn on a Lithology Layer, with the scale 
of 1:240. For example: 1 symbol every 1 meter at 1:240, 2 symbols every 1 meter at 1:120, 1 symbol every 2 meters 
at 1:480, and so on. These frequencies are only in effect if you utilize the entire interval in Oil Shows, Rounding, 
Sorting, Framework, or designated an interval in Sedimentary Structures, Traces Fossils and Rock Accessories. 
Lithology Profile - This check box  when activated will fill in the Carbonate Texture and Grain Size layers with the 
interpretive lithology. It will draw the lithology to the maximum size filled in over the interval. 

Note: The user may wish to turn off the track borders when this option is selected. You will see an 
example of this shown below. 

 
Grain Size Scale List box - You may choose between Wentworth, Canstrat or Amstrat 
scales, when using the Grain Size Builder. The Wentworth Grain size only allows full grain 
size while Canstrat / Amstrat allow half grain sizes when drafting in the Grain size and matrix 
layers. 

 This  radio button will display the Grain Size Track header with the equivalent verbal grain sizes such 
as such as C slt, VF snd, F snd, M snd, C snd etc. 

 Verbal Scale    MM Scale     
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 This  radio button will display the Grain Size Track header with the equivalent numeric grain sizes (in 
mm) such as .0625, .125, .25, .5, 1, 2 etc. as shown above. 

 This  radio button will display the grain size with strait edges and right angles between the grain sizes. 
The illustration below is shown with Lithology Profile activated. 

 Hard Edges        Soft Edges      
 This  radio button will display the grain size with curved edges and rounded angles between the grain 

sizes. 

Grain Size  This drop box allows the user to select a hatching pattern when using the 
Grain Size Layer with the Lithology Profile not activate. 
Grain Size  This color selector allows the user to pick the line color (foreground) when the fill pattern 
option is used. The background color is found in the Layer configuration for the Grain Size. 

    
 Grain Size No Pattern Hard edges Grain Size Pattern Soft edges 

Carbonate Texture  This drop box allows the user to select a hatching pattern 
when using the Carbonate Texture Layer with the Lithology Profile not activate. 
Carbonate Texture  This color selector allows the user to pick the line color (foreground) when the fill 
pattern option is used. The background color is found in the Layer configuration for the Carbonate Texture Layer. 
Carbonate Textures  This  radio button will display the grain size with strait edges and right angles 
between the Carbonate Textures. The illustration below is shown with Lithology Profile activated. 
Carbonate Textures  This  radio button will display the grain size with curved edges and rounded angles 
between the Carbonate Textures. 

-When this check box  is activated the bedding contacts (lines) between the 
drawn lithology types in the Interpretive Lithology Layer will be shown. 

 When this check box  is activated it will turn on the accessories in the 
Interpretive Lithology Layer. 
Monitor Height - This option allows you to scale your monitor for Power*Log / Core so you may correlate on-screen 
wells with hard copy logs that you may have. It is recommended that you take an opportunity to measure the vertical 
viewing area of your monitor in inches and then insert that value in the Monitor Height field. Be aware, however, that 
if you adjust the screen height knob on your monitor, this will affect the monitor height setting. 
Monitor Width - This option allows you to scale your monitor for Power*Curve so you may correlate on-screen wells 
with hard copy logs that you may have. It is recommended that you take an opportunity to measure the horizontal 
viewing area of your monitor in inches and then insert that value in the Monitor Width field. Be aware, however, that 
if you adjust the screen width knob on your monitor, this will affect the monitor width setting. 

Note: You must restart Power*Log / Core & Curve for the Monitor Width / Height changes to take effect. 
This drop box option will display your directional surveys on your log in either 
Quadrant format N 62 º W) or Azimuth format (AZ 298 º) 
Display TVD check box  when activated will display the survey with TVD values 

Display SSL check box  when activated will display the survey with SSL values 
 This check box  when activated will display the Sidewall Core Run & Core 

numbers above the core triangle indicator on the Sidewall Core layer. 
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Favorites Tab 
This tab allows the user to define their System favorites for all the data categories that support these choices. This 
tab dialogue also allows the user to access the % Lithology Sort order for the % Lithology Track. 

 
 - Allows the user to determine their favorite Rock Types and then displays them in a Toolbox menu 

generated by the activation of the Rock Type Builder window in the Interpretive Lithology track. I would not be too 
concerned about the favorites at this point in time. 

1.) Click on the  button in the System Options window, Favorites Tab. 
2.) You can now Select the following Rock Types from the Rock Type Favorites list window. 
Note: Once the category has been highlighted you can start typing in the first and second letters to pinpoint to a 
specific portion of the list. List is activated by the short name spelling. 
 Mdst [Mudstone] 
 Mrlc [Marlstone calcareous] 
 Sh blk [Shale black] 
 Sh m gy [Shale medium gray] 
 Sh brn [Shale brown] 

Ss [Sandstone] 
Sltst [Siltstone] 

4.) Click on the  button to return to the System Options window. 

- Allows the user to determine their favorite Accessories and then displays them in a pop-up menu 
generated by the activation of the Accessory Builder window in the Interpretive Lithology track / layer as well as 
the Rock Accessories track / layer. 

1.) Click on the  button in the System Options window. 

2.) Click on the  button in the Accessory Favorites list window to prepare it for the selection of your 
Accessory Favorites. 

3.) Select the following Accessories from the Thinbed, Components, and Cement headings in the Accessory 
Favorites list window. 

Note: Once the category has been highlighted you can start typing in the first and second letters to pinpoint to a 
specific portion of the list. List is activated by the short name spelling. 

Thinbed 
cht dk pebbles [chert dark pebbles] 
pyr nods [pyrite nodules] 
sh dk gy stringers [shale dark gray stringers] 
sltst stringers [siltstone stringers] 
ss stringers [sandstone stringers] 

Component 
aren [arenaceous] 
arg [argillaceous] 
calcs [calcareous] 
carb [carbonaceous] 
foss [fossiliferous] 
glauic [glauconitic] 
pl rmns [plant remains] 
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pyric [pyritic] 
micmica [micromicaceous] 
slty [silty] 

Matrix 
 arg [argillaceous] 
 kao [kaolinite] 
Cement 

calcs [calcareous] 
sils [siliceous]  no maximum 

4.) Click on the  button to return to the System Options window. 

 - Allows the user to determine their favorite Trace Fossils and then displays them in a pop-up menu 
generated by the activation of the Trace Fossil Builder window in the Trace Fossil track/layer 

1.) Click on the  button in the System Options window, Favorites Tab. 

2.) Click on the  button in the Trace Fossil Favorites list window to prepare it for the selection of your 
Favorites. 

3.) Select the following Trace Fossils from the window. 
Note: Once the category has been highlighted you can start typing in the first and second letters to pinpoint to a 
specific portion of the list. List is activated by the short name spelling. 

Trace Fossils 
Asterosoma 
Planolites 
Zoophycoes 

4.) Click on the  button to return to the System Options window. 

- Allows the user to determine their favorite Sedimentary Structures and then displays them in a pop-
up menu generated by the activation of the Sedimentary Structures Builder window in the Sedimentary Structure 
track / layer. 

1.) Click on the  button in the System Options window, Favorites Tab. 

2.) Click on the  button in the Favorites list window to prepare it for the selection of your Favorites. 
3.) Select the following Sedimentary Structures from the Bedding / Cross Bedding, Laminations / Cross 

laminations, and Other headings in the Favorites list window. 

Note: Once the category has been highlighted you can start typing in the first and second letters to 
pinpoint to a specific portion of the list. List is activated by the short name spelling. 

Bedding / Cross Bedding 
massive [massive / homogenous bedding] 
normgrad [normal graded bedding] 

Laminations / Cross laminations 
clmbrip [ climbing ripple cross laminations] 
cppxlam[current ripple cross laminations] 
wavylam[wavy laminations] 

Other 
 mudchips [mud chips] 
 root [roots / root trace] 

4.) Click on the  button to return to the System Options window. 

The Log Configuration Builder window 
 This is the heart of the Log/Track/Layer configurations and controls the way your well’s information is displayed 

on the log. 
 The well may have a lot of information stored in the database, but that information cannot be shown graphically 

on the log until the necessary layers are available to illustrate that information. 
1. Click on Log Configuration Builder under the Options menu on the Selection Bar or click on the Log 

Configuration Builder  button on the Toolbar to activate window: 
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Fundamentals of the Log Configuration Builder Window 
The left side of the Log Configuration Builder window: Available Logs 
The Available Logs section or left side of the Log Configuration Builder window allows you to take any track or 
layer from Available Logs and add it to the log you are currently creating/building. On the left side of the window, 
below the Tracks radio button , is a list of the tracks available for adding to the Active Log. 
The Available Logs section or left side of the window contains the track and layer configuration of the SYSTEM 
[SYSTEM] log, when the window first opens. You have the option of using any of the existing Tracks and their 
associated layers or any of the existing Layers, that are associated with any of the system logs in the log database. 

The user can click on the  button on the left side of the screen to activate a selection list of all 
log formats that are in your database. The list is comprised of two (2) names with the first name in the list being the 
system Log Name and the second name (in brackets), being the UWI of its primary well. Double click on the log 
format you wish to copy from. 
Below the Layers radio button , on the left side of the window, is a list of the layers available in the track 
highlighted above. They will be added all at once, if you add their parent track. However, they can also be added on 
an individual basis, if you only want to add one (1) layer to an existing Active Log track. 
The right side of the Log Configuration Builder window: Active Log 
The Active Log section or right side of the window displays the track and layer configuration of the Active Log (the 
log you are currently creating), in the main Power*Log window. The name of the log is viewed in the Log field. In this 
case, it will be “Tutorial Core Log for Facie Intervals.” Below the Tracks radio button , on the right side of 
the window, is a list of the tracks that are currently found within the Active Log. The track at the top of this list is 
drawn on the left side of the log, while the track on the bottom of the list is drawn on the far right of the log with all of 
the other tracks drawn in between, respectively. Below the Layers radio button , on the right side of the 
window, is a list of the layers that are associated with the track highlighted above. 
The middle of the Log Configuration Builder window: Selection Buttons 
The selection buttons, found in the middle column of the window, are for adding layers or tracks from the Available 
Logs to the Active Log, activating/deactivating the Active Log’s tracks, deleting active log tracks or layers, and 
moving tracks or layers within the Active Log itself. Step-by-step instructions for accomplishing these tasks are 
provided on the following pages. 
Adding a Formation Tops Track to the Tutorial Core Log 
1.) On the left hand side of the Log configuration window scroll down the list of tracks and click on the Formation 

Tops track. The track will become highlighted and the Tracks radio button will become activated. 
2.) On the right hand side of the Log configuration window click on the Gamma Ray- SP track. The track will 

become highlighted and the Tracks radio button will become activated. 

3.) In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “ Do you really want to ADD the selected (track) from the available log to the active 
log?” 

4.) Click on the  button. This will activate a Get Name window asking the user to name the track. 

5.) We will accept the Track Name so click on the  button and the track will be added above the Gamma 
Ray - SP Track or to the left on the log. 
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Deleting the Formation Top (Long name and Short name) layers from the Formation Tops track… 
1.) On the right side of the Log Configuration Builder window, click on the Formation Tops track to highlight it. 

Notice that the layers associated with this track are displayed below, in the Layers list box. 
2.) Highlight the Formation Top (Long Name) layer, in the Layers list box, by clicking on it once. Notice that the 

Layers radio button  is automatically activated by highlighting a given layer. 

3.) Click on the  button. This action will prompt you with a system message, “Do you want to delete the 

selected layer in your log?” Click on the  button. The Formation Tops (Long Name) layer has now 
been removed from the log. 

4.) Repeat Step 1-3 for removing the Formation Tops (Short Name) 

Configuring the Gamma Ray - SP track… 
1.) On the right side of the Log Configuration Builder window, click on the Gamma Ray -SP track to highlight it. 

2.) On the right side of the Log Configuration Builder window, click on the  button. This will activate 
the Track Configuration window for the Gamma Ray Track. 

 
3.) In the second heading field, type in the location, “23-001-20130”. This would help identify the location of the well. 

4.) Click on the  button. This action will prompt you with a system message, “Record Saved successfully. Do 

you wish to exit?” Click on the  button. 
Turning off a track… 
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and click on the 

Depositional Environment track. 

2.) Click on the  button to turn the “Y”(yes), to the left of the track name, to “N”(no), indicating that the 
track will not be shown on the log, until it is reactivated. 

Resizing some tracks… 
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window and click on the 

Lithology Description track. 
2.) Double click in the Track Width field and change the track width from 2.00 inches to a new width of 2.5 inches. 

Then, press the Tab key and the total width of the log itself will change to reflect the increase in the width of the 
Lithology Description track as well as the Log width field. 

3.) Scroll up the tracks list, on the right side of the Log Configuration Builder window and click on the Rock 
Accessories track. 

4.) Double click in the Track Width field and change the track width from 1.2 inches to a new width of .95 inches. 
5.) Click on the Vshale track. Double click in the Track Width field and change the track width from 2.0 inches to a 

new width of 1.4 inches. 
Moving the Oil Staining track… 
1.) On the right side of the Log Configuration Builder window, and click on the Oil Staining track to highlight it. 

2.) Click on the  button and it will change to  button. Then, click on the Physical Structures 
track. The Oil Staining track will then be placed above the Physical Structures track (to the left of the Physical 
Structures track on the log). 
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17.) Click on the  button. This will close the builder and the log will reflect all the changes you just made. 

Importing LAS Curve Data 
1. Click on the File pull down menu selection and click on Import and then click on LAS from the pop out-menu or 

simply click on the  LAS button, on the Import 
Toolbar, to activate the LAS Reader window. 

 
2. This will then activate the Open window which allows the user to select the LAS file you wish to import the data 

from. You can find the file in the PowerSuite_2016\System\100141901223W500\230012013000000.las and 

highlight the file by clicking on it once and then click on the  button. You will see the window shown 
below. We will default to the importing of Curve data. 
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Overview of window 

The left hand side of the LAS Reader window (shown on the right) allows the user to see the tree view of the data 
file format including the different data, parameter and definition blocks. The tree enables the user to select different 
sets of data or definitions. We have the choice to import these data types into the predefined data sets such as 
curves, Inclinometry, Tests, Tops and Core Data within the Power*Suite application. We default the window to select 
the log data or curve data if it is available  
The upper right hand side of the LAS Reader window (shown below) allows the user to see the data associated 
with the different data and parameters and definition blocks. 

 
The bottom left hand side of the LAS Reader window (Shown below left) displays the curve data sets that available 
to be imported. These can then be dragged to the import side of the LAS reader. 

                 
The bottom right hand side of the LAS Reader window (shown above right) shows the Import side displaying the 
Curve Layers and Curve names associated with the log that is open and active at the time the LAS Reader window 
was invoked. 
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Importing LAS Curve Data files 

 
1. On the lower left side of the window Click and drag the SP curve to the SP layer on 

the lower right side and release it when the layer becomes highlighted. 
2. You can repeat for the clicking and dragging for all the curve layers as shown above. 

Or you can open the mapping file that has been save for you by clicking on the Open 
mapping file button on the toolbar and selecting the “tutorial las mapping file.cvm” 
from the PowerSuite_2016\System\100141901223W500\ Folder. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to 
replace. The Symbol color will either be purple for replace or blue for append. 

3. The user can save this mapping procedure at this time by clicking on the  button or click on the File menu 
and Select the Save map file option and giving this procedure a file name and folder to be used again at a later 
date when you would have to import similar LAS Curve data again. 

4. Click on the  button. You will then be prompted with a system message after the import has finished. 

 

5. Acknowledge the Finished Import message. Click on the  button and then click on the  button to 
exit or click on the File menu and select the Exit option to close the LAS Reader Window. 

**Your log should now look like the log shown below** 
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Changing the Log Scale, Mouse Pointer Accuracy and changing the depth. 

 
1.)  Click on the Screen Log Scales drop box and select 1:48. This will make your screen or monitor log scale 

represent your log at a 1:48 depth scale. The user can type any scale in here between 1:1 and 1:5000. 
2.)  Click on the Screen/Mouse Pointer Accuracy drop box and select 1”. This will make your mouse pointer 

accurate down to the inch. 
3.)  Click in the Go to Depth field and type in 932 and then press the Tab Key on your keyboard to place 932 at 

the top of your Screen. The user can scroll up or down by using your mouse roller button or use the Scroll bars 
on the left side of the log. Arrow goes ¼ page, area between 
thumb and arrow full page. Thumb will not work. 

Setting up two Curve Fill layers with their 
options. 
To work with any layer the user must first select the layer from the 
Selection list. To set the Curve Fill Options the user must first make the 
Curve Fill Layers active. 
1.) Click on the Gamma Ray - SP Track containing the first Curve 

Fill layer and then select the Curve Fill layer from the Layer 
Selection List field at the far left of the Selection Bar. 

2.) Double click anywhere within the Curve Fill layer or click on the 

Toolbox  button beside the layer selection list to activate the 
Curve Fill Options window. An example is shown on the right. 

3.) Click on the  button. This will activate a list of 
curves associated with this well. 

4.) Click on the Gamma Ray and then click on the  
button or double click on the Gamma Ray Curve. You will view 

the curve name below the  button. 
Curve Options Portion of the Window. 
5.) Click on the Pattern Type down arrow and select the correct curve pattern for the main curve. The Gamma 

Ray Curve is defaulted to PtoP (Point to Point). 
6.) Click on the Grid Type down arrow and select the correct curve 

grid type for the main curve. The Gamma Ray Curve is defaulted 
to Linear. 

Fill Options 1 (One) Curve Portion of the Window. 
7.) Click on the Fill Modes – 1 Curve down arrow and select the 

Fill from curve to a value. 
8.) Type in 65 in the Value Field 
9.) Click on the Fill Patterns down arrow and select Solid 

Foreground. 
10.) Click on the down arrow beside the Foreground Color and 

select Light Yellow. 

11.) Click on the  button. The Curve Fill Options window will close 
and the changes you have made will be shown on the layer. 

12.) Click on the Layer Selection List one last time and select the 
Gamma Ray Curve Layer to make it active. This will also display 
the grid pattern on the track. 

Setting up the Second Curve Fill layer. 
1.) Click on the Resistivity Track containing the second Curve Fill 

layer and then select the Curve Fill layer from the Layer 
Selection List field at the far left of the Selection Bar. 
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2.) Double click anywhere within the Curve Fill layer or click on the Toolbox  button beside the layer 
selection list to activate the Curve Fill Options window. An example is shown on the next page. 

3.) Click on the  button. This will activate a list of curves associated with this well. 

4.) Click on the Deep Induction and then click on the  button or double click on the Deep Induction 

Curve. You will view the curve name below the  button. 
Curve Options Portion of the Window. 
5.) Click on the Pattern Type down arrow and select the correct curve pattern for the main curve. The Deep 

Induction Curve is defaulted to PtoP (Point to Point). 
6.) Click on the Grid Type down arrow and select the Logarithmic grid type for the Deep Induction curve. 
7.) The Log Cycles should be 4. If it is not type in 4 in the log cycles field. 
Fill Options 1 (One) Curve Portion of the Window. 
8.) Click on the Fill Modes – 1 Curve down arrow and select the Fill from value to a curve. 
9.) Type in 100 in the Value Field 
10.) Click on the Fill Patterns down arrow and select Solid Foreground. 
11.) Click on the down arrow beside the Foreground Color and select Green. 

12.) Click on the  button. The Curve Fill Options window will close and the changes you have made will be 
shown on the layer. 

13.) Click on the Layer Selection List one last time and select the Deep Induction Curve Layer to make it active. 
This will also display the grid pattern on the track. 

Setting up the Vshale layer / track. 
If the Vshale Curve is being displayed move on to the next section of the tutorial. You do not 
have to select this layer first as it is the only layer associated with this track. 
1.) Right Click on the Vshale track / layer. This will activate the pop out menu and Select 

the Select Gamma Ray Source. This will activate a list of curves associated with this 
well. 

2.) Select the Gamma Ray Curve by Double clicking on the Gamma Ray or click on the 

Gamma Ray and then click on the  button. This will display the calculated V 
shale using the Index method. You can select different calculation methods by clicking 
on the Calculation Method and selecting different methods. 

3.) You may want to adjust the values for clean Shale and Clean 
Sand Readings. Right Click on the Vshale curve layer to 
activate the pop out menu and Select Vshale Options. This 
will activate the Vshale Options window. In this tutorial we 
suggest you use 20 for clean and 120 for Shale. 

The user has the ability to utilize all the Curve layer functions on 
this track by right clicking. We also have a Vshale layers from Porosity Calculations and a 
layer to show the minimum Vshale values for both the GR and POR curves. 
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**Your log should now look like the log shown below** 

 
Adding Core Photos to the Core Photo Stack Layer / Track. 
This layer allows the user to insert cropped Core Photos from their individual rows in boxes to be lined up in this 
layer. 
These pictures can be done individually or imported. For the sake of this tutorial you will be importing them. But we 
will attempt to show you how one is done manually and then we will import the photos. We will start with a Core in the 
middle of the Cored Section it will be shown on the log if your top view is at 932. 

Manual Entry of Core Photo to Stacking Layer. 
1) Double click anywhere within the Core Photo Stack track to activate the Core Group builder window. 

 

2) Click on the  button. This will activate the New Core ID window show above to the right. 
3) Type the 10 into the Core ID field. 

4) Click on the  button beside the Select Graphic file. This 
will activate an Open File window. 

5) Select the 10014190123W500_07.jpg file from the 
PowerSuite_2016\System\100141901223W500 folder and 

Click on the  button this will fill in the Core ID 
window with the Core Photo to be cropped. 

6) Click on the  button beside the Select Core Profile file. 
This will activate an Open File window and select bottom 2 
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sleeves from the PowerSuite_2016\System\100141901223W500 folder. Click on the  button this 
will fill in the Core ID window with a cropping profile. These have been premade for these photos. Refer to 
manual or press the F1 key to open the on line help. 

                
7) Type 68 in the Scale % Field. 
8) Type 932 in the Top Depth Field. 
9) Type 30 in the Sleeve Length Field. 

10) Click on the  button if you want to have a look at your cropping areas. This will activate a system 
message indicating the Cropping file and the Core Photo file that is opening. 

11) Click on the  button and the Core Graphics editor will open. 

 
12) Click on the  button to close the window or the File menu and select exit. This will put you back into the 

Core ID Window. If you have made any changes you can now resave the cropping file. Click on the  
button and your core photos will be stacked at the depths entered into this window. 

13) You will have to right click on the Core Photo stack (with the builder open) and select 
the scaled view menu selection. Otherwise you will have a very narrow track with 
nothing showing until you get down to a really small scale. 

14) Click on the  button to close the Core Group window. 
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**Your log should now look like the log shown below.** 

 

Importing of Core Photos from a file to the Core Photo Stacking Layer / Track. 
This method will allow the user to import ASCII or csv file formats into our database. We cannot import xls or any 
other type of spreadsheet format. If the data comes that way you must resave it in another format before attempting 
to import the data. The actual core photos are not imported into the database. With MS Access the database is 
limited to 2GB and core photos can be up to 60MB each. This would seriously hinder the amount of data so we need 
to have the files stored on the hard drive of the computer. You will need a Core #, photo name and location, photo 
cropping template and location, Core top, Sleeve Length, and scale of the 
picture in a file. If a single core stretches itself over to 2 core photos then the above 
information will have to be re-entered with the same core number and two entries in 
the formatted data. 

How to Import Core Photos 

1. To access the Core Photos Import window, click on Import under File to 

activate the pop-out menu and then select Core Photos or click on the  
Import Core Photos Icon on the Import Toolbar. This will activate the open 
Core Photo data file window as shown below. Or you can right click on the 
Core Photo Stack layer and select the Core Photo Import Option. 

 
2. Select “core photo import file Imperial.csv” from the PowerSuite_2016\System\100141901223W500\ folder 

and either double click on the file name or click once on the file name and click on the  button. This 
will activate the Set delimiter window as shown below. You can check out the file format by opening this file in 
MSXL. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 
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Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Core Photo Import window shown below. 

 
The left hand side of the Core Photo Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Core Photo Data Import window allows the user to see the data fields associated with 
the Core Photo Data Table supplied by Power*Suite. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
survey file to database fields in the survey point table in the database. You do have one in the same folder if you 

do not want to click and drag each column over. Click on  button and select “tutorial las 
mapping file.cvm”. 

Importing / Mapping of Core Photo data. 
1. On the left side of the window Click and drag the data column you wish to import to the corresponding table 

field on the right side and release it when the field becomes highlighted. If mapped the field  will turn green 
on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 
2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 

mapped. 
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3. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

4. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window and your core photos will be stacked at the depths entered 
into this window. 
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**Your log should now look like the log shown below** 

 
Editing the Core Photo Stack Layer. 
This layer enables the user to display the Core Photo sleeves that have been cropped from Core Box photos 
generated by a photographer. The Core photos are displayed on the stacked layer and the sleeve data can be 
viewed on the sleeve data display layer. Another track that is added when you add this track will give you a 
magnification for the core sleeves to zoom in on a particular contact or feature that you wish to magnify without 
having to change the log viewing scale. These photos can be added individually or can be imported by way of an 
ASCII file with the correct information. Once the photos are displayed they can be moved as a group, moved 
individually, split, rotated, deleted, indicate rubble and or slough and can be locked to a depth and more specifically 
can be depth corrected to log data. Once these pictures have been depth corrected on a Facies log and the Facies 
have been identified then the user can use the automated Dean Stark test intervals can be run along with the 
automated Test Interval Selector and the Test Point selector to indicate the test intervals for the Core Laboratories to 
run their test interval. This data can be exported in an ASCII format for ease of testing. 

 
1.)  Click on the Screen Log Scales drop box and select 1:48. This will make your screen or monitor log scale 

represent your log at a 1:48 depth scale. The user can type any scale in here between 1:1 and 1:5000. 
2.)  Click on the Screen/Mouse Pointer Accuracy drop box and select 1”. This will make your mouse pointer 

accurate down to the centimeter. 
3.)  Click in the Go to Depth field and type in 846 and then press the Tab Key on your keyboard to place 846 at 

the top of your Screen. The user can scroll up or down by using your mouse roller button or use the Scroll bars 
on the left side of the log. Arrow goes ¼ page, area between thumb and arrow full page. Thumb will not work. 

This will place Core # 1 near the top of the screen. It has to be depth corrected as the top of the core has to be depth 
corrected to 848 feet 2 inches (848’ 2”). 

Editing the Core (Moving all of the sleeves of all the Cores) 
This would be done if the Cores have to be depth corrected to match Wireline log or if you have it an imaging tool 
data. All of this manipulation must be done with the mouse pointer. All the continuous Cores will be moved and 
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the Gaps between Cores will be modified until they are continuous and then moving will commence with these 
instructions. 

The User may now wish to turn on the Mouse Hair (this will be a Horizontal Line following the mouse pointer. With 
the line on you have a better ability to depth correct to the Well Logs. To turn on the Mouse Hair Click on the View 
Menu Selection and Select the Mouse Cross Hairs from the resulting pull down menu. 
We will start the depth correcting from the top of the Cored Interval and work our way down. It is probable the way 
most cores should be depth corrected as the most common lost core is from the bottom of the cored interval. 
1. Double click anywhere within the Core Photo Stack track to activate the Core Group window. 
2. Click on any of the any Core Sleeves in the Core in the area. Your selection will be shown in the Core Group 

Window and will become highlighted with the resizing boxes. 
3. Move Mouse pointer inside the sleeve selected  and then hold the CTRL Key down on your keypad and 

then Click and Drag (with the mouse pointer) the sleeve up (you will view the outline of the sleeve moving as 

well as the depth difference as viewed in the yellow tracker  [top left corner of screen]) and release the 
mouse button. This will activate an Update message. 

In this case I clicked in the exact spot where the contact was. This is not necessary as long as the movement was  
1’ 10” difference up. 

 
Note: The difference in the drag will be the moved distance of the Cores. In this case all the cores were moved up  
1’ 10”. So the top number is the start of your drag and the bottom number is the new depth that you have dragged to. 

4. Click on the  button. This will move all the cores up or down depending on your drag. 
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Editing the Core Photos (Adding lost Core) 
This would be done if the Core Recovery is not full. All of this manipulation must be done with 
the mouse pointer. According to the depth correction table on page 37 the base of Core 1 
sleeve 2 should be 853’ 2” and there is a lost core interval below that from 853’ 2” to 855’ 4”. 
Right Click on the Core Photo Stack layer to ensure the Lost Core Mode: Create mode is 
activated. 

1. Now, Hold down the Shift key on the keyboard and Click and drag down on Sleeve 1 
Core 2 which will become highlighted with the resizing boxes and you will see an outline 
of the sleeve moving down. 

2. Move the outline of the sleeve down until you see a difference in the mouse pointer box 
of 2’ 2”release the mouse button. This activate a System message. Create LC? 
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3. Click on the  button. This will create a lost core interval ( a colored space) from 853’ 2” to 855’ 4” as 
illustrated above. 

Note: If you happen to do something wrong remember you have an UNDO selection under the Edit Menu selection. 

Also there is an  button on the Toolbar. 

Editing the Core Photos (Removing Lost Core). 
1. Double click anywhere within the Core Photo Stack track / layer to activate the Core 

Group window. 

2. Right click on the Core photo stack layer to see if the Create Lost Core menu item is 
unchecked. 

3. Hold the Shift Key down on your keypad and Click and drag up on the sleeve below 
where the lost core was created. This will activate a System Message “Remove LC?” 

4. Click on the  button. This will decrease the lost core interval (indicated by a 
colored space) within the photos and will decrease indicating less Lost Core. 

(Undo  will be your friend to retrieve the record.) 

           

Editing the Core Photos (Emptying a portion or all of a sleeve). 
This would be done if a sleeve is empty or partially empty. Most of this manipulation can be done through the builder 
or with the right click of your mouse at a specific depth. Depending on your log scale you may have to Scroll down to 
be able to view a depth of 855’ on your screen. 

1. Right Click on the Sleeve Core 2 sleeve 1 and select empty from the pop our menu. This will remove the sleeve 
from the cored interval. . This will remove the sleeve from the core but remember it in the sleeve record table. 
And bring up a “Remove Gap?” Message. 
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2. Click on the  button. This will bring up all the underlying core intervals that are consecutive to fill in 
the gap created by the empty sleeve. 

(Undo  will be your friend to retrieve the record.) 

3. Right Click on the Sleeve Core 2 sleeve 2 at a depth of 857’ 3” and select split from the pop our menu. This 
will split the sleeve 2 and highlight the upper Sleeve 2. 

             

4. Right Click on the upper empty Core sleeve 2 and select Empty. This will remove the sleeve from the core but 
remember it in the sleeve record table. And bring up a “Remove Gap?” Message. 

 

5. Click on the  button. This will bring up all the underlying core intervals that are consecutive to fill in 
the gap created by the empty sleeve picture. 

6. Repeat Steps 3-5 for all subsequent Cores to get rid of empty (full or partially empty tubes) for all 31 Cores. 

Note: The User can also use the builder to manipulate the Cores. Splitting can only be done on the right click on the 
Core Photo Stack Layer. 
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Editing the Core Photos (Moving a sleeve within a cored interval). 
This would be done if a sleeve has been misplace during the retrieval or core photography. In this example sleeve 2 
is out of place and should be down below sleeve 4. 

1. Right Click on the Sleeve Core 2 sleeve 2 and drag the sleeve down into sleeve 4 and release the mouse 
button. This will bring up a “Do you want to resize / move?” Message. 
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2. Click on the  button. This will move sleeve 2 below sleeve 4. 

If you drag a sleeve up then the sleeve will go above the sleeve to drag it to and vice versa (as in this example) if you 

drag a sleeve down it will go below the sleeve you drag it to. (Undo  will be your friend to retrieve the record.) 

Editing the Core Photos (Emptying, Splitting, Creating lost core in the middle and the 
base and resizing the existing sleeves to the corrected depth). 
This will be done within Core # 3. As per the Core Recovery Sheet on page 37 following this section we have lost 
core from 

Core # 3 Core Interval 850’ 9” to 870’ 5” Lost Core Interval 863’ 8” to 864’ 4” 

Lost Core Interval 869’ 6” to 870’ 5” 

1. If this has already be done skip to step 4 to create lost core, or Right Click on Core 3 sleeve 1 at 861’ 10” and 
select split from the pop out menu. This will split the photo where the empty portion of the tube hits the core. 

2. Right Click on Core 3 upper sleeve 1 and select empty from the pop out menu. This will initiate the removal of 
the sleeve from the cored interval and bring up a “Remove Gap?” Message. 

3. Click on the  button. This will bring up all the underlying core intervals that are consecutive to fill in 
the gap created by the empty sleeve 
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Now we are going to create a lost core interval from 863’ 8” to 864’ 4” 

4. Right Click at 863’ 8” in Core 3 Sleeve 2 near the bottom. It has a slight break in the picture. Select split from 
the resulting pop out menu. This will split the sleeve so that we can create a lost core interval from 863’ 8” to 
864’ 4” which is a missing core section of 8”. 

5. Hold down the Shift key and click and drag the lower portion of Sleeve 2 so that the upper portion of the 
outline is around 864’ 4”. You can also follow the mouse depth box tracker and give it an 8” difference. 

6. Release the Mouse Button and this will activate the System message “Create LC?” Click on the  
button 

       
7. Right Click on the Lower Portion of Core 3 sleeve 2 and select Lock Section from the resulting pop out 

menu. This will place an X on the top of the Section and will be locked in place and this will never move from this 
point on. 

So now we will have to adjust the base of the core recovery section to match the Depth Correlated to the log. The 
base of the recovered interval on this log is 869’ 6” (869.52) and the base of the core should be at 869’ 1” (869.08). 
With this in mind we will take Core 4 Sleeve 1 and push up the bottom of Core 3 Sleeve 4 to match the depth. Ensure 
you do have a lock above and before the lost core interval. If no you will then adjust more intervals above than you 
wish. 
8. Hold down the CTRL key on your keypad and click on and drag up Core 4 Sleeve 1 up 5 inches and then 

release the mouse button. This will activate a System message “Update?” 
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9. Click on the  button. This will move the lower Core 4 Sleeve 1 up (and all the subsequent core 
below) and shrink all the core photos above by a little bit up to the Locked Section. 

10. To create more lost core, hold the SHIFT Key down on your keypad and Click and drag Core 4 Sleeve 1 
down 14” or 1’ 2”. This will activate a System Message asking “Create LC?” 

     

11. Click on the  button. This will create the lost core interval. 
12. Continue on with the depth correcting in the table below. Remember to Lock sections after lost core or even 

when you have a sleeve depth corrected so they will be locked and not move. 
Note: Once the lock has been placed the top of the interval the top depth of the locked sleeve will never move. 
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Core Depth Correction Sheet 

Below is the Core Depth Correction Sheet to help you with the Lost Core and Locking Section Below. 

Core # Cored Interval (Depth Corrected) Lost Core Intervals 

1 848’ 2” to 855’ 4” 853’ 2” to 855’ 4” 

2 855’ 4” to 650’ 9” NA 
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Core # Cored Interval Lost Core 

3 850’ 9” to 870’ 5” 863’ 8” to 864’ 4” 

869’ 6” to 870’ 5” 

4 870’ 5” to 879’ 6” NA 

5 879’ 6” to 886’ 2” 885’ to 886’ 2” 

5 886’ 2” to 896’ 8” 895’ 10” to 896’ 8” 

6 896’ 8” to 897’ 6” NA 

6 897’ 6” to 909’ 9” 909’ 4” to 909’ 9” 

7 909’ 9” to 910’ 6” NA 

7 910’ 6” to 918’ 4” 915’ 6” to 918’ 4” 

8 918’ 4” to 924’ 8” 923’ 8” to 924’ 8” 

9 924’ 8” to 931’ 3” 930’ 9” to 931’ 3” 

10 931’ 3” to 938’ 2” 935’ 6” to 938’ 2” 

11 938’ 2” to 950’ 9” 946’ 4” to 948’ 6” 

12 950’ 9 to 953’ 5” NA 

13 953’ 5” to 956’ 2” NA 

14 956’ 2” to 958’ 6” NA 

14 958’ 6” to 963’ 5” NA 

15 963’ 5” to 969’ NA 

16 969’ to 982’ 11” 978’ 2” to 982’ 11” 

17 982’ 11”to 986’ 4” NA 

17 986’ 4” to 992’ 3” 987’ 2” to 988’ 10” 

990.4” to 992’ 3” 

18 992’ 3” to 998’ 8” 

Go to page 40 in manual to Input Slough 

993’ 3” to 998’ 8” 

19 998’ 8” to 1000’ 6” NA 

19 1000’ 6” to 1006’ 5” 1005’ 5” to 1006’ 5” 

20 1006’ 5” to 1007’ 10” NA 

20 1007’ 10” to 1012’ 5” NA 

21 1012’ 5” to 1017’ 11” NA 

22 1017’ 11” to 1019’ NA 

23 1019’ to 1025’ 7” NA 

24 1025’ 7” to 1035’ 3” NA 

25 1035’ 3” to 1035’ 9” NA 

25 1035’ 9” to 1045’ 1” NA 

26 1045’ 1” to 1055” NA 

27 1055” to 1059’ 11” NA 

27 1059’ 11” to 1065’ 7” NA 
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Core # Cored Interval Lost Core 

28 1065’ 7” to 1066’ 3” NA 

28 1066’ 3” to 1074’ 6” NA 

29 1074’ 6” to 1083’ 8” NA 

29 1083’ 8” to 1084’ 4” NA 

30 1084’ 4” to 1088’ 3” NA 

31 1088’ 3” to 1093’ 2” NA 

31 1093’ 2” to 1098’ 1” NA 

Editing the Core Photos (Indicating Good Core from Rubble and Slough). 
This would be done if a sleeve has noticeable slough or rubble where you want the rubble zones to be left out of any 
Core Analysis. Or the Slough to be taken out of the Core photos. This manipulation can be done through the builder 
or the Mouse Pointer. The default when adding core sleeves is to indicate all sleeves are good core. When Slough is 
indicated the Section is removed from the Sleeve. We will preserve the Slough Interval in the Core # and Sleeve data 
ASCII export. When Rubble is indicated the Sleeve remains but the Dean Stark testing interval will be affected with 
no Tests to be performed over this rubble zone. The Core # and Sleeve Data will be indicated by a green color vs the 
normal blue color. 

Indicating Rubble 
In my example I have depth corrected down to Core 7 indicating lost core intervals and resizing some sleeves to 
make the Cored interval match the depth corrected sheet above. I have come to some rubble in Core # 7 Top of 
Sleeve 2. (Core 7 is approximately 909’ 4” -918’ 4”m) 
1. Click on the Core #7 Sleeve 4 at around 913’. Your selection will be shown in the Core Group Window and will 

become highlighted with the resizing boxes. 
2. Right Click at the depth of 913’ 7” and select Split from the resulting pop out menu. This will split the sleeve. 
3. Right Click on the Sleeve and select Rubble from the resulting pop out menu. This will keep the rubble in the 

core photos but will omit this interval when it comes to the resulting Automated Dean Stark and other Test 
intervals. 
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4. Or the User can Click on the  drop box and select Rubble or Rubble Removed from the builder 

itself and then Click on the  button and this will either remove the sleeve and for you in the case of 
Rubble or change the sleeve color from blue to green in the case of Rubble as indicated below. 

 

Indicating Slough 

We have some definite Slough in Core #18 Sleeve 2 and also in Core #20 Sleeve 2. The Sleeve 1 was empty 
and should have been deleted in the previous section. Core # 18 is located @ 992’ 3” – 998’ 8” so scroll or go 
to depth to get to that depth. Core 20 is located @ 1006’ 5” – 1012’ 5” 

Depths will vary from the tutorial depending on the empty sleeve process done in a previous section of the tutorial. 
1. Double click anywhere within the Core Photo Stack track to activate the Core Group window. 

2. Right Click on the Sleeve Core 18 sleeve 1 and select delete from the pop our menu. This will delete the 
sleeve from the cored interval. 

      
3. Right Click on the Sleeve 2 Core 18 at a depth of 993’ 9” and select split from the pop our menu. This will split 

the sleeve 2 and highlight the upper Sleeve 2. 
4. Right Click on the Sleeve Core 2 sleeve 2 upper part and select Slough from the pop out menu. This will 

activate the “Remove Gap” message box. 

5. Click on the  button. This will remove the slough and bring up the entire section of consecutive cores 
from below. 
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Depths will vary from the tutorial depending on the empty sleeve process done in a previous section of the tutorial. 
Go to Core 20 (roughly 1005’ 6” to 1010’ 7”) by scrolling with mouse roller button, scroll bars are right side of the 
screen or type 1005 in the Go To Depth field in Selection bar and then press the tab key. 
6. Right Click on Sleeve 2 Core 20 on the Photo Stacking Layer and select Slough from the menu pop out. This 

will activate the “Remove Gap” message box. 

7. Click on the  button. This will remove the slough and bring up the entire section of consecutive cores 
from below. 

Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar 

Note: The System will never allow these moves to overlap pictures. If you drag them to a Lost Core Section and you 
are not snapping to nearest they must be placed accurately as you will be moving the Lost Core Area from where you 
dragged to and replacing it where you took the picture from. 

Lost Core Created unintentionally by the software. A Remedy 

There are times when going through the depth correction process of emptying sleeves, creating lost core 
and depth correcting that there are some gaps created unintentionally between the top of the cored interval 
and the first photo. These are always in intervals below where you are working. Below is one way to get 
these unintentional lost core intervals removed. 

1. Double click anywhere within the Core Photo Stack track to activate the Core Group window. 

2. Right Click on the Core Photo Stack layer and deactivate the Create Lost Core 
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3. Hold the SHIFT Key down on your keypad and then Click and drag up on the Upper Sleeve below the lost 
core interval until the outline comes very close to the top of the cored interval. 

4. Release the mouse button and this will activate a System message asking you to “Remove LC”. 

5. Click on the  button. This will remove the lost core and bring up the entire section of consecutive 
cores from below. 

Turn on the Magnify View Layer. 
This will allow the user to view small sections of the Core at a larger scale. When depth correcting it is much easier to 
see deflections in the Curve data at larger scales (1:48 vs 1:1) where all curve data is basically linear on the screen. 
Hopefully you have completed the depth correction of the core photos. If not then you can just demonstrate to 
yourself how this works. 
1. If the Core Photo Magnify Track is not being displayed Right Click on the Core Photo Stacking Layer and 

select the Toggle Magnify View. This will turn on the Core Photo Magnify Track. If the builder was open it will 
automatically close the builder. 

         
With builder closed                   With builder open 

2. Right Click on the Core Photo Magnify track at 1084’ 3” and select one of the Magnify 1:1. This will display 
the core photos at the scale you selected on this layer. These actions are shown below. 

              

You will see red ruler style lines on the magnify view. The ruler markings are 0.5” divisions to allow the user to figure 
out at what depth the contact or physical structure you wish to identify is located. I visualize the Sand / Limestone 
contact @ 1084’ 3”. As far as the log data around this area I see the GR and Vshale curve data indicating a contact 
@ 1084’. I would then use this depth to indicate the Cretaceous / Devonian Unconformity. 

For the User to see the exact movements of your mouse you will want to turn off the Mouse Hair. Otherwise your 
movements will be seen in the upper left corner of the screen. To turn off the Mouse Hair Click on the View Menu 
Selection and Select the Mouse Cross Hairs from the resulting pull down menu. 
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Adding Interpretive Facies 
This Builder will allow you to draft on the Interpreted Facies Layer. The user can utilize this layer if they have the 
Power*Core Module. In a Facies Log this layer will control the entry of all Bed Restricted Layers. If you do not have 
an interval of Interpretive Facies you cannot enter any bed restricted data. Consequently if you resize or delete a 
Facies all bed restricted data will also be affected. 

Overview of Facies Builder window. 

 
 Button The user can enter the depths into the two depth fields with Facies selected and then click on the  

button. Their interval will now be drawn on the Interpretive Facies Track. 

 Button: The user can click on an existing interpretive Facies interval and the 

corresponding data will be shown in the builder. The user can then click on the  
button to delete the interval. 

:Check box when activated will prompt the user with a Confirmation 
window Do you really want to delete? If this  is unchecked the Facies 
Interval will be deleted without any system message. 

 This Check box when activated will not allow spaces between beds on the Interpretive Facies Layer 
when you are using the mouse (not the keypad) when entering Lithology Intervals. This function will work if you are 
within ¼” of an existing Interval and will snap to the facies interval already drawn on your log. 

 Button will activate a list of the Interpretive Facies Intervals in your active well. The user can select any 
interval from this list and can then modify or delete this interval. 

 Button allows the user to Add, Change or Delete Existing Facies Fill Types. 
 check box allows the user to turn / off the Text in the drawn facies. 

 check box allows the user to turn / off the Color Fill in the drawn facies. 
 check box allows the user to Display the Long Name of the drawn facies if the Text option is selected. 
 check box allows the user to Display the Name with an Opaque background of the drawn facies if the Text 

option is selected. 

 drop box allows the user to Display the Name of the drawn facies if the Text option is selected 
at the top centre or bottom of the drawn interval. 

 drop box allows the user to Display the Name of the drawn facies if the Text option is 
selected at the left centre or right of the drawn interval. 

 drop box allows the user to Display the Name of the drawn facies if the Text option is either 
vertically or horizontally within the facies. 

 Button will close the Facies builder. 

Right Click Menu Items 
All these menu items are described above as they are part of the Facies Builder as well. 
Once the display is the way you prefer them you will find that every time you work with this 
layer the default will now be the same as when you left the builder. 
Change Group Selection allows the user to switch to a different FACIES group. 

Adding Fill Types to the Interpretive Facies Builder 
1) Double click anywhere within the Interpretive Facies track to activate the Facies 

Builder window. 
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2) Click on the  button. This will activate the window show below. If the window has a fill already 

displayed and you want to start a new fill then click on the  button to clear the window to add a new facies. 

                   
3) Type F1 in the Facies long name into the Description field. 
4) Type F1 in the Facies short name into the Short Name field. 

5) Click on the  button and select yellow from the palette and then click on the  button. 
6) Pick Dense from the sampling Interval from the drop box. 
7) Type in a Sample Code if you wish. This is a secondary display on the Name when displayed on the Facies 

Interval. 
8) Type 20 in the Sample Size (optimum) field, Type 10 in the Sample Minimum field and Type 30 in the 

Maximum sample size field in the fields provided for the Automated Dean Stark Calculator layer / track to 
work with in the automation process. These sizes are in inches (1 foot = 12 inches). 

9) Type 4 in the Lost Core Maximum field for the Automation for sampling to be straddled over. 

10) Click on the  button or press ALT-S. The Shortcut Options window will be shown. 

 

11) To enter another Fill for Facies, click on the  button. 
12) Type F2 in the Facies long name into the Description field. 
13) Type F2 in the Facies short name into the Short Name field. 

14) Click on the  button and select grey blue from the palette and then 

click on the  button. 
15) Click on the Gradient  to activate a check mark if you want the 

gradient option. 
16) Pick NA from the sampling Interval from the drop box. 
17) Type in a Sample Code if you wish. This is a secondary display on the Name 

when displayed on the Facies Interval. 

18) Click on the  button or press ALT-S. The Shortcut Options window will 
be shown. 
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19) To enter another Fill for Facies, click on the  button. 
20) Type F3 in the Facies long name into the Description field. 
21) Type F3 in the Facies short name into the Short Name field. 

22) Click on the  button and select orange from the palette and then 

click on the  button. 
23) Click on the Gradient  to activate a check mark if you want the gradient 

option. 
24) Pick Light from the sampling Interval from the drop box. 
25) Type in a Sample Code if you wish. This is a secondary display on the Name 

when displayed on the Facies Interval. 
26) Type 30 in the Sample Size (optimum) field, Type 20 in the Sample Minimum 

field and Type 40 in the Maximum sample size field in the fields provided for 
the Automated Dean Stark Calculator layer / track to work with in the automation 
process. These sizes are in inches (1 foot = 12 inches). 

27) Type 4 in the Lost Core Maximum field for the Automation for sampling to be 
straddled over. 

28) Click on the  button or press ALT-S. The Shortcut Options window will be 
shown. 

 
29) Select  from the ensuing Shortcut Options window. This will exit the window and the new Facies have 

been added. 

Drafting an Interpreted Facies Interval (Mouse Pointer Method). 

1. Double click anywhere within the Interpreted Facies track to activate the Facies Builder window. 

 
2. Select the F2 Facies from the Facies Fill List, some faster than others. 

 The user can right click anywhere within the Interpretive Facies track to activate the pop-up menu 
shown below. Then select by clicking once on the desired Facies from the pop-up menu.  

 The user can select a Facies from the Facies field within the Facies Builder window. 
 The user can also click on a previously drawn Facies that is the same as you wish to draw with. If 

done correctly the selected Facies will be automatically displayed in the Facies field within the Facies 
Builder window. 
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3. Click and drag the mouse from  to within a specific track to define the Facies interval. Or, If there is a 
Facies defined above and below (within 300 feet) and you may want to fill in the interval simply double clicking 
in the interval and it will fill in. 

Note: This can be done on any track but more often than not the Interpretive Lithology Track is the most convenient. 
With the  activated the Facies being drawn will snap to the previous Facies either above or below 
depending on your drag if you are within ¼” of already drawn lithology. 

4. Release the mouse button and the interval will be drawn accordingly with F2. 
5. Repeat Steps 2-3 for Each Facies below. Also you can insert your own facies intervals. Up to you. 

From Depth To Depth Facies 
851’ 9” 861’ 8” F3 
861’ 8” 869’ 1” F1 
869’ 1” 929’ 8” F2 
929’ 8” 944’ 1” F1 
944’ 1” 948’ 7” F2 
948’ 7” 996’ 11” F1 
996’ 11” 999’ 4” F2 
999’ 4” 1017’ 9” F1 
1017’ 9” 1025’ F2 

1025’ 1084’ 3” F1 
1084’ 3” 1098’ 1” F2 

Drafting an Interpreted Facies Interval (Keyboard Method). 

1. Double click anywhere within the Interpreted Facies track to activate the Facies Builder window. 

 
2. Type a depth in the from Field (848.17). Press the Tab Key. This will advance the cursor to the To Field. 
3. Type a depth in the to Field (851.75). Press the Tab Key. This will advance the cursor to the Facies Field. 
4. Pick a Facies from the Facies field (F2). The user can now use the Up / Down arrows on the keypad, use the 

mouse to select from the Drop Box. 
5. The user can now select the display controls. They default from the previous use of the track so should not have 

to reset once you have setup display controls. 

6. Click on the  button. Or you can press the Enter Key on your Keypad. 
7. Repeat Steps 2-6 for the above Facies. 
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Inserting a Facies within an existing Facies 

You are able to insert thinner Facies of a different Facies Type into an existing Facies. This prevents you from 
having to re-enter the properties of the main Facies above and beneath the inserted thinner Facies. 
1. Double click anywhere within the Interpreted Facies track to activate the Facies Builder window. 
2. Select a Facies type. 
3. Click and drag the mouse button up or down within a specific track to define the Facies interval. 
4. Release the mouse button, and you will be prompted with a message asking, “Do you want to add an 

interbedded interval?” 

5. Click on the  button and the thinner bed will be drawn accordingly. 
6. Press the Esc key on the keyboard to exit from the Facies Builder window. 

Resizing an Existing Facies Fill 
1. Double click on the Interpreted Facies track to activate the Facies Builder window. 
2. Press and hold the Ctrl key on the keyboard down, while moving the mouse pointer over the Facies Fill 

boundary you wish to resize, the mouse pointer will turn into a resize , (remember if two Fills are touching to 
look into the builder to see if you have the correct one selected) 

3. Clicking and dragging the left mouse button up or down the Interpreted Facies track to either shrink or 
enlarge the selected interval. 

Note: You are not allowed to overlap an existing facies entirely and if you attempt to do so, you will receive an 
"Unsupported Add Sequence" system message. 

4. Release the mouse button at the desired depth, followed by the release of the Ctrl key on the keyboard, and the 
following system message will be activated, “Do you really want to RESIZE the interval from _ to _ ?” 

Note: Resizing a Facies will result in a resizing its associated bed restricted description category information, i.e. 
Grain Size, Porosity Grade, and so on. 

5. Press the Esc key on the keyboard to exit from the Facies Builder window. 

Deleting a Single Facies Fill. 
1. Double click on the Interpreted Facies track to activate the Facies Builder window. 
2. Right click anywhere within the Interpreted Facies track to activate the pop-up menu. 
3. Click on Delete and the following system message will be activated, “Do you really 

want to DELETE _ to _ ?” Click on the  button to confirm the deletion. 

Note: When you delete a Facies Fill, you will also delete its associated bed restricted rock 
description information, i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed 
restricted data. 

4. Press the Esc key on the keyboard to exit from the Facies Builder window. 

Deleting Multiple Facies Fills 
1. Double click on the Interpreted Facies track to activate the Facies Builder window. 
2. Hold the SHIFT Key down and then click and drag anywhere within the Interpreted Facies track and then let 

go of the Shift Key and left mouse button. This will activate a Delete Intervals message box. 

 
3. Click on  button and the Intervals dragged over will be deleted. 

Note: When you delete a Facies Fill, you will also delete its associated bed restricted rock description information, 
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data. 

4. Press the Esc key on the keyboard to exit from the Facies Builder window. 
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Automated Dean Stark Calculator Layer / Track 
This layer allows the user to calculate Dean Stark Test Intervals automatically but this layer requires Stacked Core 
Photos and Interpretive Facies Layers data for this to work. This layer is only available with our Power*Core 2015 
and beyond. This automation will only be done if you have the Interpretive Facies filled along with the Core Photo’s 
stacked. This should be the last thing you perform after the core has been depth corrected and the facies have been 
entered. The User can also enter in the data by mouse pointer or keypad methods. 

Automated Method 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Stark Test Intervals Builder 

window. 

 
2. Right click anywhere on the Auto Dean Stark Calculator track / layer to activate the pop-up menu. 

 
3. Click on the Calculate Dean Stark Intervals selection and the Intervals will be calculated for you. This will only 

be done if you have the Interpretive Facies filled along with the Core Photo’s stacked. This should be the last 
thing you perform after the core has been depth corrected and the facies have been entered. 

4. Press the Esc key on the keyboard to exit from the Dean Stark Interval Builder window. 
 

**Your log should now look like the log shown below** 
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Manually entering a Test Interval 
This is only for your information. The above test intervals will do just fine. 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Starks Intervals Builder 

window. 

 

Mouse Pointer Method 

2. Click on the  Button to clear the data entry form. 
3. Click and drag the Mouse Pointer within the Auto Dean Stark Calculator 

track / layer. 
4. Release the mouse button and the interval will be drawn with a 9999. 
5. Repeat Steps 2 – 4 for more intervals. 
6. When all your intervals have been entered you will want to Right Click on the 

layer to activate the pop out menu and select Renumber Intervals 

Or Keypad Method 

1. Click on the  Button to clear the data entry form. 

2. Type in a Top and Base Depth into the builder and then click on the  button. 
3. Repeat Steps 3-4 for more intervals. 
4. When all your intervals have been entered you will want to Right Click on the layer to activate the pop out menu 

and select Renumber Intervals 

Resizing an Interval 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Starks Intervals Builder 

window. 
2. Move the mouse pointer over the interval to be resized and Click once. This will activate the interval with the 

selection resize boxes. 
3. Hold the CTRL Key down and mouse over the edges and click and drag to a different interval. 

4. OR type in a new top and / or base depth and click on the  button. 

Deleting a Single Interval 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Starks Intervals Builder 

window. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 
3. Click on Delete option and the interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Dean Stark intervals from the Dean Stark track / layer. 
5. Once all your Dean Stark test intervals have been deleted, you will want them to come out sequentially by depth 

in the Export Utility you will want to right click on the track to activate the pop out menu and select Renumber 
Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Dean Stark Builder window. 
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Deleting Multiple Intervals 
1. Double click on the Auto Dean Stark Calculator track / layer to activate the Dean Stark Intervals Builder 

window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 
4. Click on  button and the Dean Stark intervals encompassed with your drag will be deleted 

accordingly. 
5. Once all your Dean Stark test intervals have been deleted, you will want them to come out sequentially by depth 

in the Export Utility you will want to right click on the track to activate the pop out menu and select Renumber 
Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Dean Stark Builder window. 

Automated Test Interval Calculator Layer / Track (PSD {Particle Size Distribution}) 
This layer allows the user to calculate other Test Intervals for PSD automatically but this layer requires Stacked Core 
Photos and Interpretive Facies Layers data, and can be tied to the previously entered Dean Stark intervals test for 
this to work. This layer is only available with our Power*Core 2015 and beyond. This automation will only be done if 
you have the Interpretive Facies filled along with the Core Photo’s stacked. This should be the last thing you perform 
after the core has been depth corrected and the facies have been entered. The User can also enter in the data by 
mouse pointer or keypad methods. 
Note: If the Intervals are locked to the Dean Stark Intervals and the check box is activated then the intervals will be 
drawn in Pink and the intervals not locked to Dean Stark Intervals will be in Grey. Also Vice Versa, if the Locked 
option is unchecked then the locked intervals will be drawn in grey and the unlocked intervals will be drawn in pink. 
The user can only manipulate the data when the intervals that are pink. 

Automated Method 
1. Double click on the Auto PSD Selector track / layer to activate the Core Interval Test Builder window. 

 
2. Right click anywhere on the Auto PSD Selector track / layer to activate the pop-up menu. 
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3. Click on the Lock to Dean Stark Intervals selection. This will lock the test intervals to the DS intervals 
previously entered. 

4. Right click anywhere on the Auto PSD Selector track / layer to activate the pop-up menu. 

 
5. Click on the Fill Dean Stark Intervals selection. This will fill in the Test Intervals locked to the Dean Stark 

Intervals previously performed. This will only be done if you have the Dean Stark intervals were calculated. 
6. Press the Esc key on the keyboard to exit from the Test Interval Builder window. 

**Your log should now look like the log shown below** 

 

Automated Test Interval Calculator Layer / Track (MBI {Methylene Blue Indicator}) 
This layer allows the user to calculate other Test Intervals for MBI automatically but this layer requires Stacked Core 
Photos and Interpretive Facies Layers data, and can be tied to the previously entered Dean Stark intervals test for 
this to work. This layer is only available with our Power*Core 2015 and beyond. This automation will only be done if 
you have the Interpretive Facies filled along with the Core Photo’s stacked. This should be the last thing you perform 
after the core has been depth corrected and the facies have been entered. The User can also enter in the data by 
mouse pointer or keypad methods. 
Note: If the Intervals are locked to the Dean Stark Intervals and the check box is activated then the intervals will be 
drawn in Pink and the intervals not locked to Dean Stark Intervals will be in Grey. Also Vice Versa, if the Locked 
option is unchecked then the locked intervals will be drawn in grey and the unlocked intervals will be drawn in pink. 
The user can only manipulate the data when the intervals that are pink. 

Manually entering an MBI Test Interval 
1. Double click on the Auto MBI Selector track / layer to activate the Core Interval Test Builder window. 
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2. Right click anywhere on the Auto MBI Selector track / layer to activate the pop-up menu. 

 
3. Click on the Lock to Dean Stark Intervals selection. This will lock the test intervals to the DS intervals. 

Mouse Pointer Method 

4. Click and drag the Mouse Pointer within the Auto MBI Selector track / layer from around 855’ 4” to 863’ 8”. 
Note: Just be inside the Dean Stark interval to get the MBI test to get the same depths as the DS Intervals 
5. Release the mouse button and the interval will be drawn with respect to the previously entered DS Interval and 

will be represented in pink. 

Note: If the Intervals are locked to the Dean Stark Intervals and the check box is activated then the intervals will be 
drawn in Pink and the intervals not locked to Dean Stark Intervals will be in Grey. Also Vice Versa, if the Lock is 
unchecked then the intervals will be drawn in grey. Now if you uncheck the Lock to Dean Stark Intervals the reverse 
will happen. The user can only work with the intervals that are pink. 

MBI Test Interval From Depth To Depth 
1 855.33 863.68 
2 864.33 869.08 
3 918.26 923.67 
4 924.68 930.8 
5 931.3 935.5 
6 938.13 944.08 
7 948.58 963.39 
8 963.39 978.2 
9 982.91 987.02 

10 999.33 1005.49 
11 1006.51 1017.75 
12 1025 1037.34 
13 1037.34 1049.69 
14 1049.69 1062.03 
15 1062.03 1074.38 
16 1074.38 1084.25 

4. Repeat Steps 4 – 5 with the above intervals. 
5. Once all your MBI test intervals are entered or you have added more test intervals, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Or Keypad Method 

This would probably only be utilized in the intervals that are not locked to Dean Starks as it would be 
extremely time consuming to type in the top and base of the existing Dean Stark Intervals. 

1. Click on the  Button to clear the data entry form. 
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2. Type in a Top and Base Depth into the builder and then click on the  button. 
3. Repeat Steps 7-8 for more intervals. 
4. Once all your test intervals are entered or you have added more test intervals, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

5. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Resizing an Interval 
This is only available to Intervals that are not locked with the DS Intervals. 
1. Double click on the Auto MBI Selector track / layer to activate the Core Interval Test Builder window. 
2. Move the mouse pointer over the interval to be resized and Click once. This will activate the Builder with the 

depths of the Selected Test Interval 

3. Type in a new top and / or base depth and click on the  button. 

Deleting a Single Interval 
1. Double click on the Auto MBI Selector track / layer to activate the Core Interval Test Builder window. To 

delete an interval it must be pink. If it is grey you will have to change the Lock to Unlock or vice versa. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 
3. Click on Delete and the interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Core Interval Test from the layer. 
5. Once all your test intervals have been deleted, you will want them to come out sequentially by depth in the Export 

Utility you will want to right click on the track to activate the pop out menu and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Deleting Multiple Intervals 
1. Double click on the Auto MBI Selector track / layer to activate the Core Interval Test Builder window. To 

delete an interval it must be pink. If it is grey you will have to change the Lock to Unlock or vice versa. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 
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4. Click on  button and the Core Interval Test encompassed with your drag will be deleted accordingly. 
5. Once all your test intervals have been deleted, you will want them to come out sequentially by depth in the 

Export Utility you will want to right click on the track to activate the pop out menu and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Automated Test Interval Calculator Layer / Track (SI {Soluble Ion}) 

Manually entering an SI Test Interval 
1. Double click on the Auto SI Selector track / layer to activate the Core Interval Test Builder window. 

 
2. Right click anywhere on the Auto SI Selector track / layer to activate the pop-up menu. 

 
3. Click on the Lock to Dean Stark Intervals selection. This will lock the test intervals to the DS intervals. 

Mouse Pointer Method 

4. Click and drag the Mouse Pointer within the Auto SI Selector track / layer from around 948’ 7” to 978’ 2”. 
Note: Just be inside the Dean Stark interval to get the SI test to get the same depths as the DS Intervals 
5. Release the mouse button and the interval will be drawn with respect to the previously entered DS Interval and 

will be represented in pink. 

Note: If the Intervals are locked to the Dean Stark Intervals and the check box is activated then the intervals will be 
drawn in Pink and the intervals not locked to Dean Stark Intervals will be in Grey. Also Vice Versa, if the Lock is 
unchecked then the intervals will be drawn in grey. Now if you uncheck the Lock to Dean Stark Intervals the reverse 
will happen. The user can only work with the intervals that are pink. 

SI Test # From Depth To Depth
1 948.58 978.2 
2 1025 1057.09 
3 1069.44 1081.78 

6. Repeat Steps 4 – 5 with the above intervals. 
7. Once all your SI test intervals are entered or you have added more test intervals, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 
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8. Click on the  button or Press the Esc key on the keyboard to exit from the Core Interval Test Builder 
window. 

Test Point Indicator Layer / Track 
This layer allows the user to indicate other Test points. The layer is only available with our Power*Core application 
Version 2015 and beyond. The User can also enter in the data by mouse pointer or keypad methods. 

Renaming the Test Point Indicator Layer Name 
1. Click on the Test Point Indicator Track to highlight it in a green outline. 
2. Click on the Edit Menu Selection and Select Layer Configuration from the drop list. This will the Layer 

Configuration window. 

    
3. Change the layer name to Thin Section Indicator. 

4. Click on the  button. This will activate a Database Message window. 

 
5. Click on the  button. This will close the Database Message window. 

6. Click on the  button in the Layer Configuration Window. This will close the Layer Configuration 
Window. 

Entering Thin Section Points (Mouse Pointer Method) 
1. Double click on the Thin Section Indicator track / layer to activate the Core Point Test Builder window. 

 
2. Double Click at 284.03 Core Point Test Indicator track / layer to initiate a test point. The test point will be 

drawn with a line the layer name and a depth. 
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Thin Section Point DEPTH 

1 931’ 6” 
2 964’ 
3 1011’ 6” 
4 1056’ 6” 

3. Once all your test points are entered or you have added more test points, you want them to come out 
sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

4. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Entering Test Points (Key Pad Method) 
1. Double click on the Core Point Indicator track / layer to activate the Core Point Test Builder window. 

 

2. Click on the  button and Type in a Value in the Depth field. 

3. Click on the  button. 
4. Repeat Steps 2-3 to enter more Test point data. 

  
5. Once all your test points are entered or you have added more test points, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Deleting a Single Interval 
1. Double click on the Test Point Indicator track / layer to activate the Core Point Test Builder window 

 
2. Right click on the red X indicating the Test point to activate the Pop out menu and select Delete. 

3. OR the User can also type in a corresponding value in the builder and click on the  button. 
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4. Repeat Steps 2 to delete more Core Point Test from the layer. 
5. Once all your test points are entered or you have added more test points, you want them to come out 

sequentially by depth in the Export Utility you will want to right click on the track to activate the pop out menu 
and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

Deleting Multiple Intervals 
1. Double click on the Core Point Indicator track / layer to activate the Core Point Test Builder window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 
4. Click on  button and the Core Point Test encompassed with your drag will be deleted accordingly. 
5. Once all your test points are deleted, you want them to come out sequentially by depth in the Export Utility you 

will want to right click on the track to activate the pop out menu and select Renumber Tests. 

6. Click on the  button or Press the Esc key on the keyboard to exit from the Core Point Test Builder 
window. 

**Your log should now look like the log shown below** 
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Export Core Sleeve Data 
This utility exports your (presumably) depth corrected Core Sleeve data after the Core Photos have been imported 
and cleaned up to pass back to the Laboratory label the core photos with the corrected depths. The Core sleeve data 
contains the Core #, Sleeve # along with the top and bottom of each sleeve. Also contained in this data are the core 
designation types for rubble and slough. This data can be exported into 3 file formats which can then be used by 
other applications. 

Exporting Core Sleeve Data 

To access the Export Core Sleeve Data window, click on Export under File to activate the pop-out menu and then 

select Export Core Sleeve data. You can also select the  Icon on the Export toolbar. This will activate the Export 
Core Sleeve Data Intervals window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Core Sleeve Data Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Core Sleeve Data Export File Created window. 

 

5. Click on the  button to exit Export Core Sleeve Data window. 
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Export Dean Starks Test Data 
This utility exports your Calculated Dean Starks Intervals automated by the system with the help of the Interpretive 
Facies layer. This data will be pass back to the Laboratory for the Dean Stark intervals to be performed on the core. 
The data contains the Test Type (layer Name), Test #, along with the top and bottom of each test interval. This data 
can be exported into 3 file formats which can then be used by other applications. 

Exporting Dean Starks Test Data 

To access the Export Dean Starks Test Data window, click on Export under File to activate the pop-out menu and 

then select Export Dean Starks Test Data. You can also select the  Icon on the Export toolbar. This will activate 
the Export Dean Starks Test Data window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Dean Stark Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Dean Stark Export File Created window. 

 

5. Click on the  button to exit Export Dean Stark Data window. 
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Export Core Interval Test Data 
This utility exports your Core Interval Test data (that can be locked to the Dean Stark Intervals or can be random) to 
pass back to the Laboratory for different Test Intervals to be done on the core. The Core Interval Test data contains 
the Test #, Test Type (layer name) along with the top and bottom of each Test. This data can be exported into 3 file 
formats which can then be used by other applications. 

Exporting Core Interval Test Data 

To access the Core Test Interval Data export window, click on Export under File to activate the pop-out menu and 

then select Core Interval Test. You can also select the  Icon on the Export toolbar. This will activate the Export 
Core Test Intervals window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Core Interval Test Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Core Interval Test Export File Created window. 

 

5. Click on the  button to exit Export Interval Test window. 
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Export Core Test Points Data 
This utility exports your Core Point Test data to pass back to the Laboratory for different Test Points to be performed 
on the core. The Core Point Test data contains the Test #, Test Type (layer name) along with test point for each Test. 
This data can be exported into 3 file formats which can then be used by other applications. 

Exporting Core Test Points Data 

To access the Core Test Points Data export window, click on Export under File to activate the pop-out menu and 

then select Core Point Tests. You can also select the  Icon on the Export toolbar. This will activate the Export 
Core Test Point window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify Core Point Tests Export File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will activate the Core Point Tests Export File Created window. 

 

5. Click on the  button to exit Export Point Tests window. 
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Turning Off / On Tracks that will not be required from this point on. 
The Log Configuration Builder window 
1. Click on Log Configuration Builder under the Options menu on the Selection Bar or click on the Log 

Configuration Builder  button on the Toolbar to activate window: 

 
Fundamentals of the Log Configuration Builder Window 
The right side of the Log Configuration Builder window: Active Log 
The Active Log section or right side of the window displays the tracks and layer configuration of the Active Log (the 
log you are currently creating), in the main Power*Core window. The name of the log is viewed in the Log field. In 
this case, it will be “Tutorial Core Log for Facie Intervals.”  
Turning on a track… 
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and click on the 

Depositional Environment track. 

2.) Click on the  button to turn the “Y”(yes), to the left of the track name, to “N”(no), indicating that the 
track will not be shown on the log, until it is reactivated. 

3.) Alternatively, you can simply double click on the Depositional Environment to turn the “Y”(yes) to “N”(no). The 
user might notice the log width has now increased. 

Turning off tracks… 
4.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and double click on the 

Core Box Sleeve Information, Auto DS Selector, Auto PSD Selector, Auto MBI Selector, Auto SI Selector, 
Test Point Indicator, and the Depth 2 tracks to turn the “Y”(yes) to “N”(no). This will change the log width. 

 
18.) Click on the  button. This will close the builder and the log will reflect all the changes you just made. 
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**Your log should now look like the log shown below** 

 

Adding Depositional Environments to the Depositional Environment Track 

1.) Double click anywhere within the Depositional Environment track to activate the Fills for Depositional 
Environment window. 

         

2.) Type Marine into the Description field. 
3.) Type 001 into the Short name field. 

4.) Click on the  button and select a blue color from the palette and then click on the  button. 
5.) Click on the Gradient  to activate a check mark. 

6.) Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 
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Adding more Environments to the Depositional Environment fill 
category… 

7.) Type Tidal Flats into the Description field. 
8.) Type 002 into the Short name field. 

9.) Click on the  button and select a maroon color from the palette 

and then click on the  button. 
10.) Click on the Gradient  to activate a check mark. 

11.) Click on the  button and then select  from the ensuing 
Shortcut Options window. This will clear the window and allow the user to 
enter a new record. 

12.) Type Channel into the Description field. 
13.) Type 003 into the Short name field. 

14.) Click on the  button and select a brown color from the palette 

and then click on the  button. 
15.) Click on the Gradient  to activate a check mark. 

16.) Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 

17.) Type Estuarine into the Description field. 
18.) Type 004 into the Short name field. 

19.) Click on the  button and select an orangey color from the palette and then click on the  
button. 

20.) Click on the Gradient  to activate a check mark. 

21.) Click on the  button and then select  from the ensuing Shortcut Options window. This will close 
the Add / Edit Fills Window and you will be back into the builder window. 

Drawing Environments onto the Depositional Environment Color Fill Track… 

1.) Double click on the Depositional Environment Track to activate the window. 
2.) We will want to move to the lower part of the core log so type in the Go To Depth field 1060 and press tab on 

key pad. Change your log viewing scale to 1:96 and your Mouse pointer accuracy to 1”. You should see the 
bottom of your log. 

 
3.) Right click in the Depositional Environment track to activate the pop out window, select fills and click on the 

001 selection. Or click on the builder drop box and select Marine [001]. 
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4.) If you have followed the tutorial you will have a facies drawn in over the bottom Limestone interval. You can now 

double click within the Depositional Environment track anywhere between the depths of 1098’ 1” to 1084’ 3” If 

you do not have a facies entered you can click and drag up or down from 1098’ 1” to 1084’ 3”  
within Depositional Environment track to define the interval. The Marine environment should be displayed in that 
interval. 

5.) Right click on the Marine Environment and Select opaque Text and then right click on the Marine interval 
and Select Vertical Orientation. 

6.) Right click on an empty area in the Depositional Environment track to activate the pop out window, select 
fills and click on the 003 selection. Or click on the builder drop box and select Channel [003]. 

7.) Double click within the Depositional Environment track anywhere between the depths of 1025’ to 1084’ 3”. Or 
define the interval by clicking and dragging within the environment track from or close to ¼” (if the  

is activated) 1025’ to 1084’ 3”  . You can also type in the depths in the builder and click on the  
button. The Channel environment should be displayed in that interval. 

8.) Keep scrolling up the log entering your Depositional Environments. 
Below is a table of the Depositional Environments that I have entered. 

From Depth To Depth Long Name Short Name 
1084’ 3” 1098’ 1” Marine 001 

1025’ 1084’ 3” Channel 003 
1017’ 9” 1025 Tidal Flat 002 
999’ 4” 1017’ 9” Channel 003 

996’ 11” 999’ 4” Tidal Flat 002 
948’ 7” 996’ 11” Channel 003 
944’ 1” 948’ 7” Tidal Flat 002 
929’ 8” 944’ 1” Channel 003 
869’ 1” 929’ 8” Tidal Flat 002 
861’ 8” 869’ 1” Channel 003 
851’ 9” 861’ 8” Estuarine 004 
848’ 2” 851’ 9” Marine 001 

 
To resize an existing fills hold your Ctrl Key down on your keypad and move mouse 

pointer over the end part of the interval until it turns into a resize cursor  and then 
click and drag to a new depth. Remember you cannot overwrite existing intervals. 
To delete an existing interval right click on the interval and select delete from the pop 
out menu. 
To delete multiple intervals hold the SHIFT key and click and drag over an interval 
within the Depositional Environment track and then release. 

9.) Click on the  close button in the upper right hand corner of the builder. This will close down the Environment 
builder window. 
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Adding Formation Tops 
1) Click on Formation, under Reports, OR the user can double click on the Group Formation Member Track and 

this will activate the Well Formation. The user can also utilize this window to input data for an Ages layer / track, 
a Formation Long Name and a formation short name layers / track. Our log has a formation short name layer in 
the Depth track. A Formation Evaluation and a Tops report can also be generated from this data. 

 
2) If there is a Formation Top entered (the deepest will show up upon activation) Click on the  button to clear 

the form and get you ready to enter another Formation Top. 
3) Type Clearwater into the Formation Long Name field. 
4) Select conformable from the Boundary Type drop box. 
5) Type in 803 in the Log Top (MD) field, tab and type 803 in the Log Top (TVD) field. 
6) Click on the Log radio button is the Display portion of the window. 

7) Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow you to enter a new record. 

 
8) Type Mannville into the Group long name field, tab twice, and type McMurray into the Formation Long 

Name field, tab, type um into the Member Short name field, tab, and type Upper into the Member Long 
Name field. 

9) Select conformable from the Boundary Type drop box. 
10) Type in 851.75 in the Log Top (MD) field, tab and type 851.75 in the Log Top (TVD) field. 
11) Click on the Log radio button is the Display portion of the window. 

12) Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 
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13) Type Mannville into the Group long name field, tab twice, and type McMurray into the Formation Long 

Name field, tab, type mm into the Member Short name field, tab, and type Middle into the Member Long 
Name field. 

14) Select conformable from the Boundary Type drop box. 
15) Type in 929.67 in the Log Top (MD) field, tab and type 929.67 in the Log Top (TVD) field. 
16) Click on the Log radio button is the Display portion of the window. 

17) Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 

 
18) Type Mannville into the Group long name field, tab twice, and type McMurray into the Formation Long 

Name field, tab, type lm into the Member Short name field, tab, and type Lower into the Member Long Name 
field. 

19) Select conformable from the Boundary Type drop box. 
20) Type in 1025 in the Log Top (MD) field, tab and type 1025 in the Log Top (TVD) field. 
21) Click on the Log radio button is the Display portion of the window. 

22) Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 

 
23) Type Devonian into the Formation Long Name field. 
24) Select angular unconformable from the Boundary Type drop box. 
25) Type in 1084.25 in the Log Top (MD) field, tab and type 1084.25 in the Log Top (TVD) field. 
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26) Click on the Log radio button is the Display portion of the window. 

27) Click on the  button and then select  from the ensuing Shortcut Options window. This will close 
the window and allow you to view your data entries on the log. 

**Your log should now look like the log shown below** 

 

Core Descriptions 
This report allows you to describe a Core on an interval basis. The long descriptions will be used in the Core 
Description Report that is printed out in the Well End Report print window. The ascending check box has 
been added so that user can either describe the core from the bottom up or the top down. The depth 
intervals in the Core Description window must still be entered in ascending order. 
Note: If the descriptions are entered into this Core Description report and transferred to the Corelog and then edited 
on the Corelog the descriptions entered in this Core Description reports remain unchanged. 
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The  button activates the Geology Dictionary window that allows you to add, edit and delete abbreviations 
and long forms from the expansion dictionary. 

The  button with the  check box activated will copy the from depth (from the last saved record) and 
paste it into the to field. Core Descriptions from the top down. 

The  button with the  check box not activated will copy the to depth (from the last saved record) and 
paste it into the from field. Core Descriptions from the bottom up. 
This will advance the Top Depth with the Base depth value. This will only be implemented when the record is saved. 
The  check box when activated will advance the Top Depth with the Base depth value. This will only be 

implemented when the record is saved and the  option is chosen. Core Descriptions from the top 
down. If the  check box is not activated the descending order will be implied and the Top depth will be 
place in the Base depth field. Core Descriptions from the bottom up. 

The  button displays a list of descriptions that have been entered to date for the current well. 

The  button expands the text you have typed in the Short Description field and places them in the Long 
Description field.  

The  button abbreviates the text you have typed in the Long Description field and places them in the 
Short Description field. 
Automatic Description Transfer Options 

 
The Automatic Description transfer check box  when activated will automatically transfer the sample description 
to the log when it is saved. It will transfer with the options specified in the transfer Options discussed below. 
The Transfer to Annotation Group selection drop box indicates which group the description is being transferred to. 
This window will default to Lithtext1. If this is not the group you wish to transfer you descriptions to select a different 
group from this drop box. 
Note: The first log created for a well will have a lithology description layer identified with a group called lithtext1, the 
second log created for a well will have a lithology description layer identified with a group called lithtext2 etc. The user 
can select any annotation group that exists for that well. 
The Transfer Depth Range check box  when activated will transfer the from and to depth interval to the log. 
The Transfer Top Depth Only check box  when activated will transfer only the from depth interval to the log. 
The Transfer Short Form check box  when activated will transfer the short description to the log. When this 
selection is unchecked the samples long sample description will be transferred to the log. 

Adding a Core Description 
1. Click on Core Description under the Reports menu selection to activate the Core Description window. 

2. If there is a Core Description entered (the deepest will show up upon activation) Click on the  button to 
clear the form and get you ready to enter another Core Description. 

 
3. We will setup the Core Description window to transfer the Core Descriptions in their long form, with a Top Depth 

Only, to the Lithtext1 Group. To do so make the Transfer Options according to the picture above. 
Every Lithology Description layer or Annotation Layer has a designated group associated with it. The first log created 
for a Core will have a group lithtext1 associated with it. If it is a second log for that core it will have a lithtext2 group. 
Etc. etc. etc. 



Power*Core Imperial Tutorial 2016 
 

Imperial Tutorial   Page 70 

 
4. Type 1084.25 in the From field and press the Tab key to advance to the to field and type 1098.08. Press the 

Tab key on the keyboard to move to the next field. 
5. Type in the TOP OF DEVONIAN in the Rock Type / Heading field and press the Tab key. 
6. Type the Short (abbreviated) Description shown below into the Short Description field. 

LS m - lt gy nods in lt - m gy ls mtx. Occ lt - m gy ls intbd / lt gy arg ls. TOTAL DEPTH: 1134’. 
Note: Any abbreviations that are misspelled or are not found in the Geology Dictionary will not be expanded. 
Note: When you type your abbreviations in ALL CAPS, your long description will be ALL CAPS as well. Similarly, if 
you use all lower case letters in your abbreviations, your expanded description will be all lower case. You are also 
able to use capital letters to begin your abbreviations and leave the remaining letters in lower case. This will produce 
lower case words that are capitalized in the long description. 
Note: You also have the option of typing out the non-abbreviated form of the Core Descriptions into the Long 

Description field and then clicking on the  button to display the abbreviated form of the Core 
Descriptions in the Short Description field. 

7. Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 

Note: If you Click more than once on the  button with Automatic Description transfer check box  activated 
the Core Descriptions will keep transferring to the Annotation Layer selected but will be placed 1 meter deeper. 
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8. Type 1025 in the From field and press the Tab key twice to advance to the Rock Type / Heading field. 
9. Type in the TOP OF LOWER McMURRAY in the Rock Type / Heading field and press the Tab key. 
10. Type the Short (abbreviated) Description shown below into the Short Description field. 

SS dk brn - blk sd, mas. V Rich O Sd dep. Occly / rr, mm scale m gy cly strgs @ 1032' - 1032' 6", 
1053' to 1054' 10" & 1083' - 1083' 10". 

11. Click on the  button and then select  from the ensuing Shortcut Options window. This will 
clear the window and allow the user to enter a new record. 

12. Repeat Steps 8 to 11. For the descriptions below. 
FROM 
DEPTH 

TO 
DEPTH ROCK TYPE / HEADING SHORT DESCRIPTION 

1084.25 1098.08 TOP OF DEVONIAN 

LS m - lt gy nods in lt - m gy ls mtx. 
Occ lt - m gy ls intbd / lt gy arg ls. 
TOTAL DEPTH: 1134’. 

1025 1084.25 TOP OF LOWER MCMURRAY 

SS dk brn - blk sd, mas. V Rich O Sd dep. Occly / rr, mm  
scale m gy cly strgs @ 1032' - 1032' 6", 1053' to 1054' 10" & 
1083' - 1083' 10". 

1017.75 1025 INTBD MDST AND SS Mdst pred, lt - m gy cly, / rare, mm scale, lt brn sd lams thru. 

999.33 1017.75 SS 
Dk brn - blk sd, mas. Rich o sd. Mnr Sh lam @ 998' 8"- 1001' 6", 
1016' 4"- 1016' 8". 

996.62 999.33 MDST Mdst pred, lt - m gy cly. 

948.58 996.62 SS Dk brn - blk sd, mas. Rich o sd 

944.08 948.58 MDST Lt - m gy cly intbd / com, mm scale, m - dk brn sd. 

929.67 944.08 TOP OF MIDDLE MCMURRAY SS dk brn - blk, mas o sd, Rich O Sd. 

918.17 929.67 SS INTBD / MDST Ss pred f gred, abnt o stng, dk brn to blk. Mdst fy lamd mm scale. 

869.08 918.17 MDST INTBD / SS Mdst pred, lt gy fy lamd mm scale, Ss dk brn - blk o rich. 

861.67 869.08 SS / MNR SH LAM SS pred, dk brn, o rich sd. Mdst lam dm scale, lt gy, glauic. 

851.75 861.67 TOP OF UPPER MCMURRAY Ss is lt brn, fy lamd / Mdst m gy. 

848.17 851.75 MDST m gy mdst intbd / lt brn sd & glau. 

13. Click on the  button and then select  from the ensuing Shortcut Options window. This will close 
the window and allow you to view your data entries on the log. 
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Note: IT IS IMPORTANT TO SAVE EVERY RECORD!! You must click on the  button or press ALT-S every 
time you finish entering a new record. 

Interpreted Lithology Layer - Rock Type Builder 
This window will allow you to draft on the Interpreted Lithology Layer. The user can utilize the accessory builder. The 
user may also define the basal contact if they have the Power*Core Module. This layer can be linked to the 
Interpretive facies layer on a Facies Log in Power*Core. 

Overview of Rock type builder window 

 
 Button The user can enter the depths into the two depth fields with either a rock type or no data fields filled in 

and then click on the  button. Their interval will now be drawn on the Interpretive Lithology Track. 

 Button: The user can click on an existing interpretive lithology interval and the 

corresponding data will be shown in the builder. The user can then click on the  
button to delete the interval. 

:Check box when activated will prompt the user with a Confirmation 
window Do you really want to delete? If this  is unchecked the Lithology 
Interval will be deleted without any system message. 

 This Check box when activated will not allow spaces between beds on the Interpretive Lithology 
Layer when you are using the mouse (not the keypad) when entering Lithology Intervals. This function will work if you 
are within ¼” of an existing Interval and will snap to the lithology interval already drawn on your log. 

 Button allows the user to get to the System Options Favorites Tab. The user would go into the 

 Button will access the Favorites Tab in the System Options window to change their rock favorites. 

 Button allows the user to Turn on or off the Toolbox. 

 Button will activate a list of the Interpretive Lithology Intervals in your active well. The user can select any 
interval from this list and can then modify or delete this interval. 

 Once a Lithology interval has been defined or selected and can be viewed in the builder the user can click on 

 Button to activate the Interbeds builder. 

 Button allows the user to switch to the Accessory builder so they can add accessories to the Rock type 
intervals they have defined in the Rock type builder. 

The from and to fields are entered 
manually through the key board or can be activated through a mouse drag. The rock type drop box 
will have all the rock types that are in the system. 

The Sample quality further defines the lithology interval with one of the 
three qualities such as Questionable, Poor or Rubble core / sample quality 
symbols as shown on the right. 

 
The No Data Description selection allows the user to define a 
Lithology interval on the log with one of the no data descriptions as 
shown on the right. 
 

 Once a Lithology interval has been defined or selected and can be 
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viewed in the builder the user can click drop box and add a basal contact. 

 Button will clear all the fields in the Rock Type builder. The user can then start fresh. 

 Button will close down the Rock Type builder 

Drafting an Interpreted Lithology Interval 
We want you to change your log scale to 1:48, Go to Depth of type 1080, tab out and change your Mouse Pointer 
Accuracy to 1”. 
This will be done from the Power*Core Selection bar as shown below. 

 
1. Double click anywhere within the Interpreted Lithology track to activate the Rock Type Builder 

window as well as your Favorites List Toolbox. 

 
2. Select Limestone (mud supported). There are 4 ways to select a rock type, some faster than 

others. 
 The user can click on the desired Rock Type from the Favorites Toolbox shown to the right. 
 The user can right click anywhere within the Interpretive Lithology track to activate the pop-

up menu which will also show your favorites list shown below. Then select by clicking once on 
the desired Rock Type from the pop-up menu.  

 The user can select a Rock Type from the Rock Type field within the Rock Type Builder window (all your 
rock types), if the desired Rock Type is not displayed in the pop-up menu or Toolbox. 

 The user can also click on a previously drawn lithology that is the same as you wish to draw with. If done 
correctly the selected rock type will be automatically displayed in the Rock Type field within the Rock Type 
Builder window. 

 
Note: The graphical images utilized in the pop-up menu represent specific Rock Types that can be edited by clicking 

on the  button by the user in the System Options window (See the System Options section). 

3. Because your log format is a Facies Log the user can hold the CTRL key down and double click on the 
interpretive lithology layer and the Limestone will fill in the interval that the interpretive facies has been drawn 
from 1084’ 3” to 1098’ 1”. 

 

4. Or you can Click and drag up or down within a specific track to define the lithology interval from . 
Release the mouse button and the interval will be drawn accordingly. 
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5. Or Type in the Intervals in the 1084.25 in the from field and 1098.08 in the to field in the builder and click on 

the  button. 
6. If there is a rock type defined above and below (within 300 feet) and you want to fill in the interval simply double 

click in the interval and it will fill in with the No data or Rock type selected. 

Note: The clicking and dragging can be done on any track (as long as you stay within the confines of that track) but 
more often than not the Interpretive Lithology Track is the most convenient. With the  activated the 
lithology being drawn will snap to the previous lithology either above or below depending on your drag if you are within 
1/4 inch of the already drawn lithology. 

Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Drafting some more Interpretive Lithology 

1. Select Sandstone for a rock type. 
2. If you have drawn the Interpretive Facies Intervals from a previous section you can now CTRL key down and 

double click on the interpretive lithology layer and the Sandstone will fill in the interval that the interpretive facies 
has been drawn from 1025’ to 1084’ 3”. 

 
3. Clicking and dragging over such a large interval will be impossible to do with the log scale we have. The user will 

not be able to scroll while dragging. You could change the Log Scale to 1:200 and scroll up 1 page to give you 
the ability to view the top and bottom of your drag. And now you can Click and drag up or down within a specific 

track to define the lithology interval from . Release the mouse button and the interval will be drawn with 
Sandstone accordingly. Precision at 1:200 is quite lacking at this scale. You could also start the drag to fill in 
sandstone, scroll and then resize the sandstone to fit. 

4. Or, Type in the Intervals in the 1025 in the from field and 1084.25 in the to field in the builder and click on the 

 button. 
5. If there is a rock type defined above and below (within 300 feet) and you want to fill in the interval simply double 

click in the interval and it will fill in with the No data or Rock type selected. 

Basal Contacts 
6. The user can now define the basal contact type by right clicking on 

the Sandstone bed just drawn above to activate the pop out menu. 
7. Click on Base Contact Selection to activate the pop out menu. 
8. Click on the Erosional Contact. This will fill in the contact between the 

mud support limestone and the sandstone bed you just drew. 
The basal contacts will be displayed on the interpreted lithology layer, the 
grain size and carbonate texture layers, as well at the bedding contacts 
layer if any are present. 

Drafting some more Interpretive Lithology with Interbedding 

1. Scroll up the log so you can see the interval 1017’ 9” to 1025’. 

2. Click on the  button to get rid of the Erosional Base 
Contact. Otherwise the Mudstone you are about to draw will have an erosional contact. 

3. Select Mudstone for a rock type. 
4. If you have drawn the Interpretive Facies Intervals from a previous section you can now CTRL key down and 

double click on the interpretive lithology layer and the Mudstone will fill in the interval that the interpretive facies 
has been drawn from 1017’ 9” to 1025’. 



2016                                     Power*Core Imperial Tutorial 
 

Imperial Tutorial   Page 75 

 

5. Or Click and drag up or down within a specific track to define the lithology interval from . Release the 
mouse button and the interval will be drawn with Mudstone accordingly. 

6. Or, Type in the Intervals in the 1017.75 in the from field and 1025 in the to field in the builder and click on the 

 button. 
7. Right Click on the Mudstone and select Interbedding from the pop out menu as shown below or Click on the 

lithology and Click on the  button in the Rock Type Builder. This will activate the Interbedding window 
also shown below. 

 
1. Select u cly l (Upper Clay Lower) the Main Lithology Grain Size from drop boxes 
2. Select the SS (sandstone) Secondary Lithology (Interbeds) from the drop box. 
3. Select f l snd (fine Lower) from the Secondary Lithology Grain. 
4. Fill in the 30 in both Percentage of Interbeds at the top of the interval and the base of the interval by typing in 

their respective percentages. 
5. Select a Millimeter (MM) from the Bedding Thickness drop box. 

6. Click on the  button 

7. The user can now go back to the Rock type builder by clicking on the  button. 
You will notice when you do the interbedding you will see the grain size for the Facies interval filled in on your log. 

Drafting some more Interpretive Lithology. 

1. Click on the  button to clear out the previously described Interbeds. 
2. Select Sandstone for a rock type. 
3. If you have drawn the Interpretive Facies Intervals from a previous section you can now CTRL key down and 

double click on the interpretive lithology layer and the Sandstone will fill in the interval that the interpretive facies 
has been drawn from 999’ 4” to 1017’ 9” 
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4. Or, Type in the Intervals in the 999.33 in the from field and 1017.75 in the to field in the builder and click on 

the  button. 

We can now simply click on the Mudstone / Sandstone interbed drawn from 1017’ 9” to 1025’. and then redraw with 
these rock properties at another interval. 

1. Click on the Mudstone / Sandstone interbed drawn from 1017’ 9” to 1025’ 
2. Scroll up in your log so you can see around 996’ 11” – 999’ 4”. 
3. If you performed step 1 you can now CTRL key down and double click on the interpretive lithology layer 

between 996’ 11” – 999’ 4” and the Mudstone Interbedding will fill in the interval that the interpretive facies has 
been drawn from 996.92 to 999.33. 

 
4. Or Click and drag up or down within a specific track from 996’ 11” to 999’ 4” to define a new lithology interval. 
5. Release the mouse button and the interval will be drawn accordingly. 

6. Click on the  button in the Rock Type Builder or right click on the drawn lithology and select 
Interbedding from the pop out menu. This will activate the Interbedding builder. 

 
7. Select u cly l (Upper Clay Lower) the Main Lithology Grain Size from drop boxes 
8. Select the SS (sandstone) Secondary Lithology (Interbeds) from the drop box. 
9. Select vf l snd (very fine Lower) from the Secondary Lithology Grain. 
10. Fill in the 30 in both Percentage of Interbeds at the top of the interval and the base of the interval by typing in 

their respective percentages. 
11. Select a Millimeter (MM) from the Bedding Thickness drop box. 

12. Click on the  button 

13. The user can now go back to the Rock type builder by clicking on the  button. 

Drafting some more Interpretive Lithology. 
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1. Click on the  button to clear out the previously described Interbeds. 
2. Select Sandstone for a rock type. 
3. Scroll up so you can see the interval to a portion of the interval from 948’ and 997’. 
4. If you have drawn the Interpretive Facies Intervals from a previous section you can now CTRL key down and 

double click on the interpretive lithology layer and the Sandstone will fill in the interval that the interpretive facies 
has been drawn from 948’ 7” to 996’ 11”. 

 
5. Or, Type in the Intervals in the 948.58 in the from field and 996.92 in the to field in the builder and click on the 

 button. 

Repeat the above procedures for the rest of the intervals defined below. Italic ones have been done. 

Rock Type From Depth To Depth 
Limestone 1098.08 or 1098’ 1” 1084.25 or 1084’ 3” 
Sandstone 1084.25 or 1084’ 3” 1025 
Interbedded Mudstone and Sandstone 1025 1017.75 or 1017’ 9” 
Sandstone 1017.75 or 1017’ 9” 999.33 or 999’ 4” 
Interbedded Mudstone and Sandstone 999.33 or 999’ 4” 996.92 or 996’ 11” 
Sandstone 996.92 or 996’ 11” 948.58 or 948’ 7” 
Interbedded Mudstone and Sandstone 948.58 or 948’ 7” 944 
Sandstone 944 929.67 or 929’ 8” 
Interbedded Mudstone and Sandstone 929.67 or 929’ 8” 869.08 or 869’ 1” 
Sandstone 869.08 or 869’ 1” 861.67 or 861’ 8” 
Interbedded Sandstone and Mudstone 861.67 or 861’ 8” 851.75 or 851’ 9” 
Mudstone 851.75 or 851’ 9” 848.17 or 848’ 2” 

Inserting Lost Core Intervals 
Once the Interpretive Lithology has been entered there are two ways to getting the Lost 
Core Intervals Inserted. The Core Photo Stack method described is by far the easiest. 

Core Photo Stack Layer Method 
1. Double click anywhere within the Core Photo Stack track / layer to activate the 

Core Group window. 

2. Right click on the Core Photo Stack layer to activate the pop out menu. 

3. Select Add Lost Core to Lithology Selection from the pop out menu. This will 
activate a Warning Message. 

  

4. Click on the  button. This will active the Add Interbedded Interval Message window repeatedly for all 
the Lost Core Intervals to be added. 

5. Click on the  button repeatedly for all the lost core intervals indicated in the Core Photo Stack layer. 
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Interpretive Lithology Layer method. 
1. Double Click on the Interpretive Lithology track to activate the builder. 

 

2. Click on the  button to clear out the previously described lithology. 

3. Select Lost Core from the No Data Descriptions from the drop box.  
4. Click and drag the mouse button up or down within the Core Photo Stack track 

(orange area from 1005’ 6” to 1006’ 6”) specific track to define the No Data interval. 
5. Release the mouse button, and the interval will be drawn accordingly. A message box will 

appear. 

 

6. Click on the  button. 
7. Repeat steps 4-6 for all the lost core intervals indicated in the Core Photo Stack Layer. 

Deleting Interbedding in an Interpreted Lithology Interval. 

The following procedure will delete the Interbedding only. If you wish to delete the entire lithology delete the Lithology 
from the Rock type builder. 

1. Double click anywhere within the Interpreted Lithology track to activate the Rock Type 
Builder window as well as your Favorites List Toolbox. 

2. Right Click on the drawn lithology and select Interbedding from the pop out menu as 

shown below or Click on the lithology and Click on the  button in the Rock Type 
Builder. This will activate the Interbedding window also shown below. 

           
3. Click on the  button 
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4. The user can now go back to the Rock type builder by clicking on the  button. Also the user can go to 

the accessory builder by clicking on the  button. Or the user can exit the builder altogether by clicking on 

the  button. 
5. Press the Esc key on the keyboard to exit from the Interbedding window. 

Inserting Thin beds 

You are able to insert thinner beds of a different Rock Type into an existing bed. This prevents you from having to re-
enter the properties of the main bed above and beneath the inserted thinner bed. The Rock Accessories (Thin 
beds, Components, Matrix and Cement) are the only properties that are not retained from the existing bed. 
1. Double click anywhere within the Interpreted Lithology track to activate the Rock Type Builder window 

previously shown as well as your Favorites List Toolbox. 
2. Select a rock type. There are 4 ways to select a rock type. 

 The user can click on the desired Rock Type from the Favorites Toolbox. 
 The user can right click anywhere within the Interpretive Lithology track to activate the pop-up menu 

shown below. Then select by left clicking once on the desired Rock Type from the pop-up menu.  
 The user can select a Rock Type from the Rock Type field within the Rock Type Builder window, if the 

desired Rock Type is not displayed in the pop-up menu or Toolbox. 
 The user can also click on a previously drawn lithology that is the same as you wish to draw with. 

3. If done correctly the selected rock type will be automatically displayed in the Rock Type field within the Rock 
Type Builder window. 

4. Click and drag the mouse button up or down within a specific track to define the Lithology interval. 

Note: This can be done on any track but more often than not the Interpretive Lithology Track is the most convenient. 

5. Release the mouse button, and you will be prompted with a message asking, “Do you want to add an 
interbedded interval?” 

6. Click on the  button and the thinner bed will be drawn accordingly. 
7. The user can now define the base contact type by right clicking on the drawn interpretive lithology interval 

and selecting the desired basal contact type. 
8. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

Resizing an Existing Rock Type or Bed 
1. Double click on the Interpreted Lithology track to activate the Rock Type Builder window. 
2. Press and hold the Ctrl key on the keyboard down, while moving the mouse pointer over the lithology bed 

boundary you wish to resize, the mouse pointer will turn into a resize , (remember if two beds are touching to 
look into the builder to see if you have the correct one selected) 

3. Clicking and dragging the left mouse button up or down the Interpreted Lithology track to either shrink or 
enlarge the selected interval. 

Note: You are not allowed to overlap an existing bed (lithology) entirely and if you attempt to do so, you will receive 
an "Unsupported Add Sequence" system message. 

4. Release the mouse button at the desired depth, followed by the release of the Ctrl key on the keyboard, and the 
following system message will be activated, “Do you really want to RESIZE the interval from _ to _ ?” 

Note: Resizing a Rock Type will result in a resizing its associated bed restricted description category information, i.e. 
Grain Size, Porosity Grade, and so on. 

5. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

Deleting a Single Rock Type or Bed 
1. Double click on the Interpreted Lithology track to activate the Rock Type Builder 

window. 
2. Right click anywhere within the Interpreted Lithology track to activate the pop-up 

menu. 
3. Click on Delete and the following system message will be activated, “Do you really 

want to DELETE _ to _ ?” Click on the  button to confirm the deletion. 
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Note: When you delete a Rock Type, you will also delete its associated bed restricted rock description information, 
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data. 

4. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

Deleting Multiple Rock Types or Beds 
1. Double click on the Interpreted Lithology track to activate the Rock Type Builder window. 
2. Hold the SHIFT Key down and then click and drag anywhere within the Interpreted Lithology track and then 

let go of the Shift Key and left mouse button. This will activate a Delete Intervals message box. 

 
3. Click on  button and the Intervals dragged over will be deleted. 

Note: When you delete a Rock Type, you will also delete its associated bed restricted rock description information, 
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data. 

4. Press the Esc key on the keyboard to exit from the Rock Type Builder window. 

**Your log should now look like the log shown below** 

 

Drawing Grain Size 
The Entire interval is applicable to the Interpretive Facies interval. The entire interval would contain all of the drawn 
interpretive facies interval. For the following entire intervals to work the Double Click Interval Entry, Snap to closest 
lithology and Soft Edges must be activated or checked as seen in the builder. 

1.) Double click on the Grain Size track to activate the Grain Size Builder window. 
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2.) Double click the mouse pointer between the depths 1025’ to 1084’ 3”  on the (f l snd) in the 
Grain Size track. The entire Grain Size interval will be drawn in purple accordingly. (Purple to represent an 
entire interval.) 

Note: Measured Depths and Grain Sizes can be viewed within the mouse pointer display box, situated to the right 
of the mouse pointer or top left corner of screen with the Mouse Cross hair activated. 

3.) Double click the mouse pointer between the depths 999’ 4” to 1017’ 9”  on the (vf l snd) in the Grain 
Size track. The entire Grain Size interval will be drawn in purple accordingly. (Purple to represent an entire 
interval.)  

4.)  Double click the mouse pointer between the depths 948’ 7” to 996’ 11”  on the (f l snd) in the 
Grain Size track. 

5.)  Double click the mouse pointer between the depths 929’ 8” to 944’ 1”  on the (m l snd) in the Grain 
Size track. 

Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Drawing Grain Size with a sequence type… 

6.)  Click and drag the mouse pointer from 869’ 3” [f u snd] to 

861’ 9” [u c slt]  on the Grain Size track. Then, 
release the mouse button and the Grain Size interval will be 
drawn accordingly. 

7.)  Right Click between the interval 861’ 9” to 869’ 3” on the 
grain size track and select Entire Interval Sequence from 
the pop out menu and select Fining Upwards from the 
resulting pop out menu. 

10.) To exit from the Grain Size Builder window and return to the log, press the Esc key on the keyboard once. 

**Your log should now look similar to the log shown below** 
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Oil Staining Layer 

This layer allows you to add or delete Oil staining in the Power*Core application. . There is a Bed or Facies 
Restricted (BR) and a Non-Bed or Facies Restricted (NBR) layer types. In our case we have only Bed or Facies 
restricted layers. So if you do not have a facies it will be impossible to draw oil staining. 
The bed restricted (BR) layer type is like a typical rock property layer (sorting, rounding grain size) where you have 
to have an Interpretive Lithology or Facies in order to enter an oil staining. The oil staining is also restricted to the 
interval you are drawing in. Also, when the interval is resized or deleted the oil staining symbol may be also resized or 
deleted if the oil staining interval coincides with the beds resized or deleted interval. 
The non-bed restricted (NBR) layer type is not associated with any Interpretive lithology or facies interval and can 
be entered anywhere the user wishes and will not be affected by the resizing or deleting of a bed. 
Snap To : When checked allows the user to snap to the previous data entry if you click and drag within 10 
times the mouse pointer or screen scale accuracy of the previous data entry. 
 
We will want to move down to the first Channel Sand of the core log so type in the Go To Depth field 925 and press 
tab on key pad. Change your log viewing scale to 1:48 and your Mouse pointer accuracy to 0.5”. You should see 
the first Channel Sand. You can also use the scroll bars on the side of the log. 

 

Adding an Oil Staining type over an Entire Interval 
1. Double click on the Oil Staining track / layer to activate the Oil stains window. 

 
2. Right click anywhere on the Oil staining track / layer to 

activate the pop-up menu and select the intensity selection to 
activate its pop out menu as shown below or click directly 
into the builder and utilize the drop down menu section. 

3. In our case a mix is not required so Skip to Step 4. If it 
was required Right click anywhere on the Oil staining track / layer to activate the pop-up menu and select the 
mix selection to activate its pop out menu as shown below or click directly into the builder and utilize the drop 
down menu section. 

 
4. Double Click on the Oil Staining layer within the interval between 929’ 8” and 944’ 1” (Make sure  

 is checked) and it will be drawn accordingly. 
5. Continue Scrolling down the log and enter the same information over all the Channel Sands. The depth 

intervals would be 948’ 7” to 996’ 11”, 999’ 4” to 1017’ 9”, 1025’ to 1084’ 3” 
6. Repeat Step 4 -5 to add Black Staining. 
7. Press the Esc key on the keyboard to exit from the Oil Stains builder window. 

Adding an Oil Staining type over a subinterval. 
Scroll up the log so you can see the area between the depths of 855’ and 870’. 
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1. Right click anywhere on the Oil staining track / layer to 

activate the pop-up menu and select the intensity selection to activate its 
pop out menu as shown and select Dk Brn or click directly into the 
builder and utilize the drop down menu section: 

2. If a mix is required Right click anywhere on the Oil staining track / layer 
to activate the pop-up menu and select the mix selection to activate its 
pop out menu as shown and select Gas or click directly into the builder 
and utilize the drop down menu section. 

3. Click and drag the mouse on the track / layer from 861’ 7.5” to 866’ 

10”. . The dark brown oil staining and Gas Mixture will be 
drawn accordingly. 

Tip: The frequency of mix symbols (G & W) at any given scale is handled in the Systems Options window, under 
Options. If you have selected 1 symbol every 5 ft at the 5” scale, you will get 1 symbol every 10 ft at the 2”  scale, 1 
symbol every 20 ft at the 1”scale, and so on. 

4. Repeat Steps 2 - 4 to add more subintervals at your discretion to the track. 
5. Press the Esc key on the keyboard to exit from the Oil Stains builder window. 

Resizing an Interval 
Mouse Pointer Method 

1. Press the Ctrl key down on the keypad and move the mouse pointer over the interval ends. If done correctly 
the mouse pointer will turn into double arrows.  

2. Click and drag the mouse to the new desired top or bottom depth. Release the mouse button and the interval 
will be resized. 

Keypad Method 

1. Click once on the Oil Stain you want to resize to bring it into the builder and change the from or to depth and / or 

abundance and click on the  button. Remember if it is a bed restricted layer that the top or bottom of 
the Lithology interval will take precedent. 

Deleting an interval 
1. Double click on the Oil Staining track / layer to activate the Oil Stains builder window. 

                         
2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 
3. Click on Delete and the Oil Staining interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Oil Staining intervals from the Oil Staining track / layer. 
5. Press the Esc key on the keyboard to exit from the Oil Stains Builder window. 
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Physical Structures Layer 
This layer allows you to add or delete physical structures in the Power*Core application. There are two types of 
sedimentary structure layers. There is a Bed Restricted (BR) and a Non-Bed Restricted (NBR) layer types. 
The bed restricted (BR) layer type is like a typical rock property layer (sorting, rounding grain size) where you have 
to have an Interpretive Lithology or Facies in order to enter a sedimentary structure. The physical structure is also 
restricted to the interval you are drawing in. Also, when the Lithological or Facies interval is resized or deleted the 
physical structure symbol may be also resized or deleted if the physical structure interval coincides with the beds 
resized or deleted interval. 
The non-bed restricted (NBR) layer type is not associated with any Interpretive lithology or facies interval and can 
be entered anywhere the user wishes and will not be affected by the resizing or deleting of a bed. 
The number of Physical Structures you can put in is limited to the width of the track. Change the track size if you wish 
to put in more or less within a certain Facies Interval. 
Snap To : When checked allows the user to snap to the previous data entry if you click and drag within ¼” 
the mouse pointer or screen scale accuracy of the previous data entry. 
 
Adding a Physical Structure over an Entire Facies Interval 

Note: In our Case the physical structures is a bed restricted layer / track and have to be associated with an 
Interpretive Facies Interval and must have an interval in order to be saved to the database. Therefore, you cannot 
add a sedimentary structure, until there is a Facies interval added to that Layers for that interval. 

1. Double click on the Physical Structure track / layer to activate the Sedimentary Structures Builder window 

and toolbox. The toolbox can be turned on or off by clicking on the  button in the builder. 

To add or remove items from your favorites Click on the  button in the builder, this will activate the 

System Options Favorites Tab and then click on the  button. Remember to  on the way 
out of the System Options window to save your changes. 

                        
2. Right click anywhere on the Physical Structure track / layer to activate the pop-up menu. 

 
3. Click on the Sedimentary Structures favorites list to activate the pop out menu and then select current ripple 

cross laminations from the pop out favorites list or click in the builders drop down menu selections to access 
the list provided in them. Either way once you have selected one it will be populated in the builder. 
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4. Double Click within an existing Facies interval in the Sedimentary 

Structure layer with the  activated and the entire 
facies interval will be filled in with current ripple cross laminations. 

5. Right click on the existing current ripple cross laminations sedimentary structure, Click on the Abundance 
selection to activate the pop out menu and then select Trace from the pop out list. This will change the line style 
of color of the surround 

6. Or click on the existing current ripple cross laminations sedimentary structure and then click in the builders 
Abundance drop down menu selections to access the list provided in them. Click on the  button. 

7. Repeat Steps 2-6 to enter more Sedimentary Structures over entire Facies Intervals. 
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Adding a Physical Structure over a Portion of a Facies Interval 
1. Right click anywhere on the Physical Structure track / layer to activate the pop-up menu. 

 
2. Click on the Sedimentary Structures favorites list to activate the pop out menu and then select wavy 

laminations from the pop out favorites list or click in the builders drop down menu selections to access the list 
provided in them. Either way once you have selected one it will be populated in the builder. 

 
3. Click and drag within an existing Facies interval in the Sedimentary 

Structure layer and the interval you dragged will be filled in with wavy 
laminations. 

4. Right click on the existing wavy laminations sedimentary 
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structure, Click on the Abundance selection to activate the pop out menu and then select Trace from the pop 
out list. This will change the line style of color of the surround 

5. Or click on the existing wavy laminations sedimentary structure and then click in the builders Abundance 
drop down menu selections to access the list provided in them. Click on the  button. 

6. Repeat Steps 2-5 to enter more Sedimentary Structures. 

Note: Click and drag the mouse on the track / layer close to an existing sedimentary structure (either above or 
below in the same column) with the  activated and there will be no spaces between the sedimentary 
structures. Remember you have to be within ¼” of the mouse pointer or screen accuracy from the previous symbol to 
have the snap to take effect. 

7. Press the Esc key on the keyboard to exit from the Sedimentary Structure Builder window. 

Resizing an Interval 
1. Double click on the Physical Structure track / layer to activate the Sedimentary Structure Builder window. 

Mouse Pointer Method 

2. Click on the symbol you wish to resize. If done correctly it will indicate with the resize boxes. 
3. Press the Ctrl key down on the keypad and move the mouse pointer over the interval ends and then Click 

and drag the mouse to the new desired top or bottom depth. If done correctly the mouse pointer will turn into 

resize cursor . 
4. . Release the mouse button and the interval will be resized. 

Keypad Method 

1. Click once on the Sedimentary Structure you want to resize to bring it into the builder and change the from or to 

depth and / or abundance and click on the  button. Remember if it is a bed restricted layer that the 
top or bottom of the Lithology interval will take precedent. 

Moving an Interval 
1. Double click on the Physical Structure track / layer to activate the Sedimentary Structure Builder window. 
2. Move the mouse pointer over the interval to be moved and Click once. This will activate the symbol with the 

selection move boxes. 

3.  Hold the CTRL Key down and Click and drag the interval to a new position. Your cursor will turn into a  if 
done correctly. (The bed-restricted interval will not be allowed to move outside the interval of the lithology it is 
associated with.) 

Deleting a Single Interval 
1. Double click on the Physical Structure track / layer to activate the Sedimentary Structure Builder window. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 
3. Click on Delete and the Sedimentary Structure interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Sedimentary Structure intervals from the Physical Structure track / 

layer. 
5. Press the Esc key on the keyboard to exit from the Sedimentary Structure Builder window. 
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Deleting Multiple Intervals 
1. Double click on the Physical Structure track / layer to activate the Sedimentary Structure Builder window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 
4. Click on  button and the Physical Structure interval encompassed with your drag will be deleted 

accordingly. 
5. Press the Esc key on the keyboard to exit from the Sedimentary Structure Builder window. 

Rock Accessory Layer 
This layer allows you to add or delete Rock Accessories in the Power*Core application. There are two types of Rock 
Accessories layers. There is a Bed Restricted (BR) and a Non-Bed Restricted (NBR) layer types. 
The bed restricted (BR) layer type is like a typical rock property layer (sorting, rounding grain size) where you have 
to have an Interpretive Lithology or Facies in order to enter a Rock Accessory. The Rock Accessories are also 
restricted to the interval you are drawing in. Also, when the Lithological or Facies interval is resized or deleted the 
Rock Accessory may be also resized or deleted if the Rock Accessory interval coincides with the beds resized or 
deleted interval. 
The non-bed restricted (NBR) layer type is not associated with any Interpretive lithology or facies interval and can 
be entered anywhere the user wishes and will not be affected by the resizing or deleting of a bed. 
The number of Rock Accessories you can put in is limited to the width of the track. Change the track size if you wish 
to put in more or less within a certain Facies Interval. 
Scroll down to the base of your log or use the selection bar to type 1078 in the Go To Depth field and TAB out. 

 

Adding a Rock Accessory over an Entire Facies Interval 

Note: In our Case the Rock Accessory is a bed restricted layer / track and have to be associated with an 
Interpretive Facies Interval and must have an interval in order to be saved to the database. Therefore, you cannot 
add a Rock Accessory, until there is a Facies interval added to that Layers for that interval. 

1. Double click on the Rock Accessories track / layer to activate the Rock Accessory Builder window and 

toolbox. The toolbox can be turned on or off by clicking on the  button in the builder. 

To add or remove items from your favorites Click on the  button in the builder, this will activate the 

System Options Favorites Tab and then click on the  button. Remember to  on the way 
out of the System Options window to save your changes. 
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2. Right click anywhere on the Rock Accessories track / layer to 

activate the pop-up menu. 

 
3. Click on the Rock Accessories favorites list to activate the pop 

out menu and then select Limestone Mud Supported Clasts 
from the pop out favorites list or click in the builders Thinbed drop 
down selections to access the list. The user can start typing in the 
list to get close to your choice. Either way once you have selected one it will be populated in the builder. 

4. Double Click within an existing Facies interval in the Rock Accessories layer with the  
activated and the entire facies interval will be filled in with Limestone Mud support Breccia. 

5. Right click on the existing Limestone Mud support Breccia 
rock accessory, Click on the Abundance selection to 
activate the pop out menu and then select Abundant from the 
pop out list. This will change the line style of color of the 
surround 

6. Or click on the existing Limestone Mud support Breccia rock 
accessory and then click in the builders Abundance drop 
down menu selections and select Abundant. Click on the 

 button. 
7. Repeat Steps 2-6 to enter more Rock Accessories over entire Facies Intervals. 
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Adding a Rock Accessory over a Portion of a Facies Interval 
8. Right click anywhere on the Rock Accessories track / layer to activate the pop-up menu. 

 
9. Click on the Rock Accessories favorites list to activate the pop out menu and then select glauconitic from the 

pop out favorites list or click in the builders drop down menu selections to access the list provided in them. 
Either way once you have selected one it will be populated in the builder. 
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10. Click and drag within an existing Facies interval in the Rock Accessories layer and the interval you dragged will 

be filled in with Glauconitic. 
11. Right click on the existing Glauconitic Rock Accessory. Click on 

the Abundance selection to activate the pop out menu and then select 
Trace from the pop out list. This will change the line style of color of 
the surround 

12. Or click on the existing Glauconitic Rock Accessory and then click 
in the builders Abundance drop down menu selections to and select 

common. Click on the  button. 
13. Repeat Steps 2-5 to enter more Rock Accessories. 

Note: Click and drag the mouse on the track / layer close to an existing Rock Accessory (either above or below in 
the same column) with the  activated and there will be no spaces between the Rock Accessories. 
Remember you have to be within ¼” of the mouse pointer or screen accuracy from the previous symbol to have the 
snap to take effect. 

14. Press the Esc key on the keyboard to exit from the Rock Accessory Builder window. 

Resizing an Interval 
1. Double click on the Rock Accessories track / layer to activate the Rock Accessory Builder window. 

Mouse Pointer Method 

2. Click on the symbol you wish to resize. If done correctly it will indicate with the resize boxes. 
3. Press the Ctrl key down on the keypad and move the mouse pointer over the interval ends and then Click 

and drag the mouse to the new desired top or bottom depth. If done correctly the mouse pointer will turn into 

resize cursor . 
4. Release the mouse button and the interval will be resized. 

Keypad Method 

2. Click once on the Rock Accessory you want to resize to bring it into the builder and change the from or to 

depth and / or abundance and click on the  button. Remember if it is a bed restricted layer that the 
top or bottom of the Lithology interval will take precedent. 

Moving an Interval 
4. Double click on the Rock Accessories track / layer to activate the Rock Accessory Builder window. 
5. Move the mouse pointer over the interval to be moved and Click once. This will activate the symbol with the 

selection move boxes. 

6.  Hold the CTRL Key down and Click and drag the interval to a new position. Your cursor will turn into a  if 
done correctly. (The bed-restricted interval will not be allowed to move outside the interval of the lithology it is 
associated with.) 
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Deleting a Single Interval 
1. Double click on the Rock Accessories track / layer to activate the Rock Accessory Builder window. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up 

menu. 
3. Click on Delete and the Rock Accessory interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Rock Accessories intervals from the Rock 

Accessories track / layer. 
5. Press the Esc key on the keyboard to exit from the Rock Accessory Builder window. 

Deleting Multiple Intervals 
1. Double click on the Rock Accessories track / layer to activate the Rock Accessory Builder window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 
4. Click on  button and the Rock Accessories interval encompassed with your drag will be deleted 

accordingly. 
5. Press the Esc key on the keyboard to exit from the Rock Accessory Builder window. 

Ichnofossils Layer 
This layer allows you to add or delete Ichnofossils in the Power*Core application. There are two types of Rock 
Accessories layers. There is a Bed Restricted (BR) and a Non-Bed Restricted (NBR) layer types. 
The bed restricted (BR) layer type is like a typical rock property layer (sorting, rounding grain size) where you have 
to have an Interpretive Lithology or Facies in order to enter an Ichnofossils. The Ichnofossils are also restricted to the 
interval you are drawing in. Also, when the Lithological or Facies interval is resized or deleted the Ichnofossils may be 
also resized or deleted if the Ichnofossils interval coincides with the beds resized or deleted interval. 
The non-bed restricted (NBR) layer type is not associated with any Interpretive lithology or facies interval and can 
be entered anywhere the user wishes and will not be affected by the resizing or deleting of a bed. 
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The number of Ichnofossils you can put in is limited to the width of the track. Change the track size if you wish to put 
in more or less within a certain Facies Interval. 
Scroll down to the base of your log or use the selection bar to type 1078 in the Go To Depth field and TAB out. 

 

Adding an Ichnofossil over an Entire Facies Interval 

Note: In our Case the Ichnofossils is a bed restricted layer / track and have to be associated with an Interpretive 
Facies Interval and must have an interval in order to be saved to the database. Therefore, you cannot add a 
Ichnofossil, until there is a Facies interval added to that Layers for that interval. 

1. Double click on the Ichnofossils track / layer to activate the Trace Fossil Builder window and toolbox. The 

toolbox can be turned on or off by clicking on the  button in the builder. 

To add or remove items from your favorites Click on the  button in the builder, this will activate the 

System Options Favorites Tab and then click on the  button. Remember to  on the way 
out of the System Options window to save your changes. 

                  
2. Right click anywhere on the Ichnofossils track / layer to activate the pop-up menu. 

 
3. Click on the Trace Fossils favorites list to activate the pop out 

menu and then select Cruziana from the pop out favorites list or 
click in the builders Trace Fossil drop down selections to 
access the list. The user can start typing in the list to get close to 
your choice. Either way once you have selected one it will be 
populated in the builder. 

4. Double Click within an existing Facies interval in the Ichnofossils 

layer with the  activated and the entire facies 
interval will be filled in with Cruziana. 

5. Right click on the existing Cruziana trace fossil, Click on the 
Abundance selection to activate the pop out menu and then 
select Trace from the pop out list. This will change the line style 
of color of the surround 

6. Or click on the existing Cruziana trace fossil and then click in 
the builders Abundance drop down menu selections and 
select Abundant. Click on the  button. 

7. Repeat Steps 2-6 to enter more Ichnofossils over entire Facies Intervals. 
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Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also there 

is an  button on the Toolbar. 

Adding an Ichnofossils over a Portion of a Facies Interval 
1. Right click anywhere on the Ichnofossils track / layer to activate 

the pop-up menu. 

 
2. Click on the Trace Fossils favorites list to activate the pop out 

menu and then select Teichichnus from the pop out favorites list 
or click in the builders drop down menu selections to access the 
list provided in them. Either way once you have selected one it 
will be populated in the builder. 

 
3. Click and drag within an existing Facies interval in the Ichnofossils 

layer and the interval you dragged will be filled in with Teichichnus. 
4. Right click on the existing Teichichnus Trace Fossil. Click on the 

Abundance selection to activate the pop out menu and then select 
Trace from the pop out list. This will change the line style of color of 
the surround 

5. Or click on the existing Teichichnus Trace Fossil and then click in the builders Abundance drop down menu 
selections to and select Occasional. Click on the  button. 

6. Repeat Steps 2-5 to enter more Ichnofossils. 

Note: Click and drag the mouse on the track / layer close to an existing Ichnofossils (either above or below in the 
same column) with the  activated and there will be no spaces between the Ichnofossils. Remember 
you have to be within ¼” of the mouse pointer or screen accuracy from the previous symbol to have the snap to take 
effect. 

7. Press the Esc key on the keyboard to exit from the Trace Fossil Builder window. 

Resizing an Interval 
1. Double click on the Ichnofossils track / layer to activate the Trace Fossil Builder window. 

Mouse Pointer Method 

2. Click on the Trace Fossil symbol you wish to resize. If done correctly it will indicate with the resize boxes. 
3. Press the Ctrl key down on the keypad and move the mouse pointer over the interval ends and then Click 

and drag the mouse to the new desired top or bottom depth. If done correctly the mouse pointer will turn into 

resize cursor . 
4. Release the mouse button and the interval will be resized. 

Keypad Method 

5. Click once on the Trace Fossil you want to resize to bring it into the builder and change the from or to depth 

and / or abundance and click on the  button. Remember if it is a bed restricted layer that the top or 
bottom of the Lithology interval will take precedent. 
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Moving an Interval 
1. Double click on the Ichnofossils track / layer to activate the Trace Fossil Builder window. 
2. Move the mouse pointer over the interval to be moved and Click once. This will activate the symbol with the 

selection move boxes. 

3. Hold the CTRL Key down and Click and drag the interval to a new position. Your cursor will turn into a  if 
done correctly. (The bed-restricted interval will not be allowed to move outside the interval of the lithology it is 
associated with.) 

Deleting a Single Interval 
1. Double click on the Ichnofossil track / layer to activate the Trace Fossil Builder window. 

 
2. Right click anywhere within the interval you wish to delete to activate the pop-up 

menu. 
3. Click on Delete and the Trace Fossil interval will be deleted accordingly. 
4. Repeat Steps 2 and 3 to delete more Trace Fossil intervals from the Ichnofossils 

track / layer. 
5. Press the Esc key on the keyboard to exit from the Trace Fossil Builder window. 

Deleting Multiple Intervals 
1. Double click on the Ichnofossils track / layer to activate the Trace Fossil Builder window. 

 
2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 
3. Release the mouse button to activate a Confirm Multiple Delete message. 

 
4. Click on  button and the Trace Fossils interval encompassed with your drag will be deleted 

accordingly. 
5. Press the Esc key on the keyboard to exit from the Trace Fossils Builder window. 
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**Your log should now look similar to the log shown below** 

 

Core / Sample Header 
The Core / Sample Header window allows you to edit the information being displayed when the Core log header is 
printed. Below are some examples of the Headers for your Core Log. 
 

 
Core Log Header 

 
Alternate Core Log Header 
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How to Edit a Core / Sample Header 
1. Click on the Core / Sample Header selection located under the Edit pull down menu and then either Select 

Standard Format. An example of the Alternate Format shown below. 

   

  
2. In the Logged by field, type in the name of the person who the core is logged by. 
3. In the Top Depth and Base Depth fields, type in the Top Depth and Base Depth of the core / sample interval. 
4. In the Depth Corrected Remark field, type in the remark related to depth change that you wish to appear at the 

core log header. 
5. Activate the Slabbed check box , if you wish the core log header to be cut in half. This is not applicable to the 

Sample Log abbreviated Header. 
6. In the Quality Remark field, type in the remark related to quality that you wish to appear at the core log header. 
7. In the Remarks field, type in any other remarks that you wish to appear on the Core Log header. 

N.B. The Remarks field is limitless as the Core Header Expands to the appropriate size to accommodate the entire 
Remarks Field. To start a new line just depress the Enter Key on your keypad. 
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Well Record Data portion of the Core / Sample Header window 

1. Click on the  button to enter KB and Ground Elevation. The Well window will be shown. 

 

2. In the KB field, enter the KB. In the Ground / Collar, enter the ground elevation as well as the UTM coordinates 
and the Hole ID if you have them. 

3. Click on the  button or press ALT-S. This will activate the Core Header window showing the KB and 
Ground Elevation that you have just entered. 

4. Click on the  button. If the record has been successfully saved, click on the appropriate button when 
prompted with the Shortcut Options system window. 

Print to TIFF (file format) 
Prints all or part of your log/well along with the Title page, location map, legends, survey views, 
individualized cores and formation tops on a continuous basis in a tiff file format. In our Case we have only 
Cores and have not made a regular Core Log through the Core Report we only have a striplog. We will also 
print the regular Core Log Header. 

1. Under the File menu selection, click on Print to TIFF or click on the  Print to TIFF button on the Toolbar to 
activate the Print to TIFF window shown on the next. 
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Note: The depth views associated with the Print TIFF window are defaulted to the Depth View that Power*Log / Curve 
/ Core is in at the time of the activation of the Print to TIFF window. 

 

2. Select tabloid landscape the appropriate paper orientation from this 
drop box field and the Dynamic Legend will automatically conform to the selected orientation. There are six (6) 
types of paper orientation to choose from: letter (8.5”x11”) portrait or landscape, legal (8.5”x14”)portrait or 
landscape, tabloid (11”x17”) portrait or landscape settings. 

3.  Activate this check box  to printout a Core Log Title Page. 
4. The Type (Title Page) drop box displayed on the right allow you to pick the appropriate title 

page format to print. Select an abbreviated Core title that handles our core log. 

5.  If you are in Alberta the AER format should be selected. 

6. Activate this check box , if you wish to printout a logo, and then select a logo from the Logo 
drop box field. 

Note: The logo file format must be a bitmap image file (*.bmp) if you want a logo printed out on the title page. Also, it 
is recommended that the bitmap image should be a square image, because Power*Suite will shrink or expand the 
image to fit the logo space on the Title Page. This bitmap must be placed in the Powersuite_2015\logo directory for 
the application to find it. 

7.  Activate these check boxes . The Dynamic legend reflect only the symbols 
printed on the log. 

In the Log portion of the Print Log window 

8. Print Scale select 20 or type in the Scale for 
the log to be printed out at, in the Scale drop 
box field. 

9.  Activate this check box  
to have the track headers /footers printed out 
with the main log. 

10. Highlight the log printing options in the 
selection box. Click on the User Defined 
Section and type in 848 and 1099 in the from and to fields. 

11. When you are ready to print your log, click on the  button. 

12. This will activate a message box indicating the size of your printout. Click on the  button. 
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13. This will activate a file name window which should be filled in with your file name and location to where you can 
locate it for further reference. 

Note: If you do exit from the Print to TIFF window, you will be asked if you wish to save the print settings. If you 
click on Yes, the program will remember every setting that you made to the Print to TIFF window and then will 
default to those settings the next time you enter the Print to TIFF window 

Adding a Link (Attachment) to your Log 
1.) In our case Right Click on the Grain Size track / layer to activate the pop out menu. Select Add / Edit / Open 

Link from the pop out menu. This will activate a blank Links window with the depth you right clicked at. 

 

2.) Click on the  button in the Links window and you can now pick any windows compatible file. In our case 
we will link the printed well file from the next section of the tutorial printed to my backup folder and then click on 

the  button. This will fill in in the details of the File Name and location in this window. 

    

3.) Now the user can Type in some remarks to tell the viewer what the file is (if the user wishes to identify the file 

they have attached) and then click on the  button. This will activate the Shortcut Options Window. 

 

4.) Click on the  button. This will insert the paper clip symbol  where you originally right clicked and link 
the file to the log. 

This concludes the Power*Core Tutorial. If you need help with specific functions or 
operations, please use the Table of Contents in the Power*Log / Core User Manual to find 
the desired topic or use the Search function built into the On-line Help. 


